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About this Guide

The Symposium TAPI MCA 2.0 Reference Guide provides detailed instructions on how to install and configure
the Meridian Communications Adapter (MCA) and the Symposium Desktop TAPI Service Provider 2.0 for
MCA (TAPI SP for MCA).  Information in this document is intended for use by MCA users, telephony server
administrators, and developers who are responsible for installing, configuring, maintaining and using the MCA
with the TAPI SP for MCA.  This document is written based upon the assumption that you have some
experience working with computers, TAPI, telephony products, and Microsoft Windows.  In this guide, the
Meridian Communications Adapter is referred to as the MCA and the Nortel Symposium Desktop TAPI Service
Provider 2.0 for MCA is referred to as the TAPI SP for MCA.  When combined, these two are referred to as the
Symposium TAPI MCA 2.0.

Note:  The TAPI SP for MCA software contains a README.TXT file.  This file provides information not
available when this document was printed.  Always read this information prior to beginning installation.

This guide is divided into the following chapters and appendices:

Chapter 1, “Overview,” provides a summary of the MCA, TAPI, and of the TAPI SP for MCA.

Chapter 2, “Installing and Configuring the MCA,” describes in detail how to complete the installation of the
MCA.

Chapter 3, “Installing the TAPI SP for MCA,” provides information on installing the TAPI SP for MCA
software .

Chapter 4, “Configuring the TAPI SP for MCA,” provides information on configuring the TAPI SP for
MCA.

Chapter 5, “Getting Results using the TAPI MCA” describes how to become more efficient using the TAPI
MCA product.

Chapter 6, “Troubleshooting Tips,” provides information for additional installation acceptance testing using
the JulMar TAPI Phone Dialer tool and for running the Logger Tool.  In addition, it also describes
possible problems and the actions to resolve these problems.

The Appendices provide additional user information that may be helpful when installing and using the
MCA and the TAPI SP for MCA.

Appendix C identifies the differences between the Desktop TAPI 1.6 and the TAPI SP for MCA.  In
addition, it lists the features, line functions, and display formats that the TAPI SP for MCA supports.

In addition, this guide contains a Glossary that lists telephony services terms and definitions used in this
document.  A Table of Contents and Index provide assist you in locating the desired information.

For additional information or help, call the Nortel Developer Support Hotline at
(800) NT-4CTI-0.  For information about other Nortel Networks products, call (800) 4-NORTEL (466-7835).
Outside the United States and Canada, contact your Nortel Support or Sales representative.

Note:  This document can not be ordered from Nortel Networks using the Publication number on the inside
cover page.  This document is only available online with the software.
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Document Conventions

The following conventions are used in this document:

1. The individual keys that users are instructed to press appear inside angle brackets.
For example: <Enter> or <F1>

2. “Press,” “ Choose,” or “Click on” means to position the cursor over an option, then press and release
the left mouse button to activate control and carry out an action.

3. "Select" means to position the cursor over an option, then press and release the left mouse button to
highlight the selection.

4. "Double-click" means to position the cursor over an option, then press and release the left mouse
button twice.

5. Information that users are instructed to type appears in bold, italic print.
For example:  Type User Id  or  Enter User Id

6. Menu commands and options that are displayed on the window appear in bold print, such as the Exit
option located on the File menu on the Menu bar.

7. Window, screen, dialog box, or data entry field names display in italic print, such as, the Open field on
the Run dialog box.

8. “Button” refers to a click or push button displayed on the window that is clicked on or pressed to carry

out an action.  For example:  Click on the OK  button or Click on 

9. “Check box”  refers to a square box displayed on the window that is clicked on to select or to clear an
option.  For example:  � -- option not selected  or  _ -- option selected

10. “Option button”  refers to a circle displayed on the window that is clicked on to select or to clear an

option.  For example:  { -- option is not selected  or  m -- option is selected

11. Note: Identifies important User information and special instructions.

Note:  Notes display in paragraphs separated from other text.
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Related Documents

Documents that you may need to reference, but are not necessarily required for configuring or using the TAPI
SP include:

• MS-Windows User’s Guide - Available from Microsoft Corporation

• MS-DOS User’s Guide - Available from Microsoft Corporation

• Nortel Symposium Desktop TAPI Service Provider Implementation Planning Guide - Available from
Nortel - Available from the Nortel Web Site (www.nortel.com/bap/sales.htm) with the Nortel
Symposium Desktop TAPI SP Developer Tool Kit.

• Nortel Symposium Desktop TAPI Service Provider Programmer’s Guide - Available from the Nortel
Web Site (www.nortel.com/bap/sales.htm) with the Nortel Symposium Desktop TAPI SP Developer
Tool Kit.

• Getting Started with Nortel Symposium Communicator - Available with Nortel Symposium
Communicator product.

• Getting Started with Nortel Symposium Multimedia Conferencing - Available with the Nortel
Symposium Multimedia Conferencing product.

• Getting started with Nortel Symposium Call Manager - Available with the Nortel Symposium Call
Manager product.
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 Chapter 1  Overview

 This chapter provides an overview of the Symposium TAPI MCA and contains information about Computer
Telephony enablers and the Meridian Communications Adapter.  Also included in an overview of Microsoft's
Telephony Applications Programming Interface (TAPI).

 Overview of the Symposium TAPI MCA

 Nortel Networks is a leader in delivering solutions that meet customer needs.  The Symposium TAPI MCA,
Symposium Desktop TAPI Service Provider (SP) 2.0 user licenses, and Symposium TAPI Phone products
below enable you to run TAPI compliant applications on your Desktop PC.

 PEC CPC Description
 NT5P70DA B0252860 Symposium TAPI MCA 2.0
 NT5P70DB B0252886 Symposium TAPI MCA 2.0 Legacy (kit)
 
 NT5P70CA B0252859 Symposium Desktop TAPI Service Provider 2.0 - Single User License
 NT5P70CB B0252861 Symposium Desktop TAPI Service Provider 2.0 - 10 User License
 NT5P70CC B0252862 Symposium Desktop TAPI Service Provider 2.0 - 50 User License
 NT5P70CD B0252863 Symposium Desktop TAPI Service Provider 2.0 - 100 User License
 NT5P70CE B0252864 Symposium Desktop TAPI Service Provider 2.0 - 500 User License
 
 NT5P50CA B0252883 Symposium TAPI Phone (M2216ACD) (kit)
 NT5P50CB B0252884 Symposium TAPI Phone (M2616) (kit)
 NT5P50CC B0252885 Symposium TAPI Phone (M2008)

 For example; users who already have a Meridian Modular Telephone equipped with an MCA simply need to
install the Symposium Desktop TAPI Service Provider software using any one of the user license packages
above.  The software is provided on a CD-ROM containing two versions; 1.6 and 2.0.  You must choose which
version to install, based on the following information:

• Version 1.6 of the TAPI SP operates on Windows 3.1/3.11/WFW & Win 95 PC’s equipped with
Microsoft TAPI 1.3/1.4.

• Version 2.0 of the TAPI SP for MCA operates on Windows NT 4.0, Windows 2000, Windows 98 and
Windows 95 PC's equipped with Microsoft TAPI 2.0/2.1.

 Users who have only a Meridian Modular Telephone must install one of the Symposium TAPI MCA packages
above, which consists of an MCA, the TAPI SP for MCA 2.0 software and an RS-232 cable.

 Users who do not have a Meridian Modular Telephone can install one of three types of Symposium TAPI Phone
packages; a black M2008, M2216 or M2616 packaged with the TAPI MCA items listed above.

 
 There are a variety of applications available such as Symposium Call Manager and Microsoft's Outlook 97 that
offer Computer Telephony Integration (CTI) solutions.  Refer to Chapter 5 Getting Results for more information
on TAPI Compliant Applications.
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 Overview of the Computer Telephony (CT) Enablers

 A Computer Telephony Enabler is a combined hardware/software solution that can be added to your PC that
allows your PC applications to monitor or control a telephone in some way.  In a sense, the CT Enabler
integrates your PC and telephone; allowing you to manage calls more effectively using your PC application. The
Symposium TAPI MCA is only one of the Computer Telephony (CT) Enablers that Nortel provides.  The table
below shows some other Computer Telephony Enablers.

 CT Enabler  First Party or
Third Party

 Switch  Hardware  Microsoft
Software

 Nortel
Networks
Software

 Symposium
TAPI MCA

 First Party  Meridian 1  MCA  Microsoft TAPI
2.1 on Desktop
PC

 TAPI Service
Provider for
MCA 2.0

 Symposium
Communicator
2.0

 First Party  Meridian 1
or MSL-100

 Communicator
Card

 Microsoft TAPI
1.3/1.4 on
Desktop PC

 Symposium
Desktop TAPI
Service
Provider 1.6

 Symposium
TAPI Service
Provider for
Meridian 1

 Third Party  Meridian 1  Meridian Link,
Direct Connect
(AML/ELAN)
or SCCS Link

 Client PC:
Microsoft TAPI
2.1

 

 Win NT 4.0
Server:
Symposium
TAPI SP for
M1 Release 2

 CompuCALL
TAPI Driver
R1

 Third Party  DMS-100 or
MSL-100

 CompuCALL  Client PC:
Microsoft TAPI
2.1

 

 Win NT 4.0
Server:
CompuCALL
TAPI Driver
R1

 For third party call control, Nortel offers the Symposium TAPI Service Provider for Meridian 1 Release 2 and
the CompuCall TAPI Driver.  For information about these and other Nortel Networks products, call (800) 4-
NORTEL (466-7835).  Outside the United States and Canada, contact your Nortel Support or Sales
representative.
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 Meridian Communications Adapter

 The Meridian Communications Adapter (MCA) is an asynchronous/synchronous data card that fits into the base
of Meridian Modular Telephones.  Attached to the MCA via its RS-232 serial port is your personal computer as
shown below.  The personal computer needs some special communications software written specifically for it in
order to access its serial port and communicate with the MCA.

 The Meridian Communications Adapter (MCA) is capable of operating in two modes; Data Mode or Call
Control Mode.  The default mode is data mode and it is sometimes used with data/internet access applications
such as Procomm, Crosstalk, Netscape or Internet Explorer to communicate with other data service providers.
Refer to Appendix "B" for information on how to use the MCA in data mode.

 This document focuses on the use of the MCA in “Call Control” mode only which is the mode that is always
used when the MCA is part of a CT Enabler; supporting TAPI Applications via the TAPI SP for MCA 2.0.
When a TAPI application is started on your PC, it sends an Initialize command to Microsoft's Telephony API
(TAPI) which in turn sends a command to the TAPI SP for MCA.  The TAPI SP for MCA receives the
command from TAPI and tells the MCA to enter “Call Control” mode.  The application can then invoke its call
control features to place and answer calls, put calls on hold, transfer and conference calls and release calls.  The
TAPI SP for MCA interprets these requests and works with the MCA and the switch to process them.  When the
TAPI Application quits, the MCA is returned to Data Mode.

 

 
 Figure 1  Meridian Communications Adapter with the Meridian 1 PBX

 The newer version of the MCA (NT2K69AA) eliminates the requirement for the Power Board Option
(NT2K10WD) to power the MCA on the Meridian (Modular) Digital telephone.  This reduces installation time
by eliminating the need to open the telephone to install the Power Board Option.
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 Figure 2  Meridian Communications Adapter without external power

 With XII release 18 and later, the MCA can be programmed with telephone keypad commands, and service
change prompts (LD 11).  X11 releases 14 through 17 support keypad programming only.

 Just as your phone has a unique Directory Number (extension), the MCA must have its own data Directory
Number configured in the system if used in Data Mode.  A data directory number IS NOT needed for the MCA
when operating in Call Control mode and supporting TAPI Applications.

 The MCA uses EEPROM non-volatile read/write memory for permanent storage of settings and configuration
parameters.
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 Overview of TAPI
 The introduction of new computer telephony integration (CTI) standards allows businesses of all sizes to
develop new applications integrating computers and telephone systems.  Microsoft and Intel created Telephony
Application Programming Interface (TAPI).  The Telephony technology integrates computers with the telephone
network.
 
 Nortel offers TAPI compliant applications as well as Service Providers.  Service Providers (SP) are the software
files needed to enable TAPI applications to communicate with the physical telephony device.  Nortel offers
TAPI SPs for Meridian 1, Norstar, MSL-100, DMS Meridian Digital Centrex business systems.

 

MCA

TAPI Software Implementation
TAPI Hardware Implementation

Run-time Software

Symposium

FastView

Symposium

Call Manager

Outlook 97 Future

Applications

Meridian 1

TAPI SP TAPI SP

Norstar

TAPI SP

     MSL-100

TAPI SP

Centrex

Telephony Application Programming Interface - Microsoft TAPI

Service Provider Interface  -  Nortel Symposium TAPI SP

TAPI Compliant

0
Meridian Modular Telephone

 Figure 3  TAPI Overview

 Microsoft's Operating System and TAPI software have evolved over the years and understanding which releases
are compatible with Nortel Network's Desktop TAPI Service Providers is important.  Refer to the Table below.
 
 Microsoft
TAPI Release

 Desktop
TAPI SP
Release

 Win 3.1  Win
3.11

 Windows for
Workgroups

 Win
95

 Win
98

 Win
NT
4.0

 Win
2000

 1.3  1.5/1.6  Y  Y  Y     
 1.4  1.5/1.6  N  N  N  Y    
 2.0  2.0     Y  Y  Y  Y
 2.1  2.0     Y  Y  Y  Y
 3.0  2.0     Y  Y  Y  Y

 
 
 The Nortel Symposium Desktop TAPI service providers, available as standalone development kits, are capable
of being included in a variety of applications.  The Telephony Application Programming Interface (TAPI) gives
developers a consistent set of tools for creating the windows-based telephony applications.
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 Overview of the TAPI SP for MCA 2.0

 The Nortel Symposium Desktop Telephony Application Programming Interface (TAPI) Service Provider (SP)
release 2.0 for MCA is also referred to as the TAPI SP for MCA in this document. Version 2.0 provides 32-bit
functionality.

 The TAPI SP for MCA provides the JulMar TAPI Phone Dialer tool and the TAPI Logger tool to help with
troubleshooting.  The JulMar TAPI Phone Dialer tool is provided to assist you in verifying that TAPI SP for
MCA is working after it is installed and configured.  The Logger tool allows you to create a log file that
provides information to assist technical personnel in troubleshooting problems.  These tools are detailed in
Chapter 6.

 TAPI Application Relationships

 Figure 4  TAPI Application Relationships shows the relationship between Microsoft TAPI, Nortel TAPI SPs,
and TAPI applications.  Version 2.0 of the TAPI SP for MCA does not support MBS sets as illustrated below
but version 1.6 does and it is available on the version 2.0 CD-ROM.

 

 Figure 4  TAPI Application Relationships

 Implementation Planning Process

 The process of implementation planning starts by determining what you want to do and how your TAPI
application will help you do it.  You need to determine how the TAPI application can take advantage of the
information presented to the set.  Keep in mind that most applications that are compatible with Microsoft
windows support the output of information to a printer and the input of data through a modem, scanner or
mouse.  This information exchange is usually handled or controlled by a special driver that typically manipulates
the data in some way.
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 TAPI applications rely on the TAPI SP for MCA to manipulate the exchange of information between the
personal computer’s COMM 1, COMM 2, COMM 3, or COMM 4 port and a telephone using an MCA.

 Call Presentation

 TAPI compliant applications usually support the ability to place calls, answer calls, hold and un-hold calls,
transfer and conference calls, as well as other features.  However, one of the most important functions of the
TAPI Service Provider is to interpret the information that is presented to the telephone set and pass that
information on to the TAPI compliant application through an interface device.  This is called “Call
Presentation.”

Symposium TAPI MCA 2.0 interprets only information presented to the bottom line of the phone set’s display.
DNIS, which appears on the top line, is not captured or interpreted.  Calling ID and Called ID information
delivered to the TAPI application follows these supported formats.  Refer to the “Supported Display Formats”
section located in Appendix C for the supported formats.

 Many TAPI compliant applications, such as Nortel Symposium FastView and Nortel Symposium Call Manager
use the information to perform a particular function.  This function may include call routing or screen pops.  In
addition, we recommend that you check with your telephone system administrator to determine which functions
are available at your location.
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 Chapter 2  Installing and Configuring the MCA

 This chapter provides instructions and information for installing and configuring the Meridian Communications
Adapter (MCA).  Appendix B provides additional information on using the MCA.

 Requirements for Installing the MCA

 The Meridian Communications Adapter (MCA) must be installed, configured, and working before installing the
TAPI SP for MCA software.  The MCA resides in the digital telephone foot stand.  The MCA allows personal
computers to connect to the Meridian Modular Telephone, using an RS-232C interface on a DB-25 connector.

 If you currently have a working MCA, you will have to install the new foot stand only.

 Telephone Compatibility

 The MCA is forward and backward compatible with the following Meridian Modular Telephones:

• M2006
• M2008
• M2008HF
• M2616
• M2216ACD

 The MCA has the following exclusions:

• Due to UL and CSA considerations, digital telephones equipped with an MCA cannot be wall mounted.

• Foot stands supporting the use of an ATA and Key Expansion Modules, NT2K22, for the M2616 and
M2216ACD telephones are not available.

• The NT2K69AA version of MCA cannot be used on Meridian Digital Telephones where the
NT2K10xx Power Board is required.

• For safety reasons, Meridian Digital Telephones that have been previously wall mounted, require
replacement of the foot stand with the bottom knock-out still intact.

 Note:  The wall mount knockout located on the bottom of the telephone foot stand must be in place.  If
the knockout is damaged or missing, you must replace the foot stand with a new one before installing
the MCA.
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 Meridian 1 PBX Requirements

 Meridian 1 PBX  Requirement

 Meridian 1 Software
Release Requirements

 The software release required:
• for Meridian SL-1 -- X11 Release 14 or greater

• for Meridian 1 Option 11 --  X11 Release 16 or
greater

• for Meridian 1 Option 21-81  -- X11 Release 15 or
greater

 Meridian 1 Feature
Requirements

 CPND, ADD, CNDA, DNDA

 Digital Line Card
Requirements

 The MCA can be equipped on Meridian Digital Telephones
on the following equipment:

• Enhanced Peripheral Equipment (EPE) with
QPC578 line card

• Intelligent Peripheral Equipment (IPE) with the
NT8D02 line card.

 Telephone Requirements  M2006, M2008, M2008HF, M2216ACD, M2616, M3110,
M3310, M3820

 

 MCA Hardware Requirements

 The following table describes the hardware requirements for the various MCA models.

 Table 1  MCA Hardware Requirements

 Required MCA Hardware  NT9K  NT2K
Later than
April 1998

 NT2K
Prior to
April 1998

 NTZK

 MCA printed circuit board  9  9  9  9

 24V AC power adapter  9  9  9  9

 Jumper board  Pre-installed  Pre-installed  9  9

 Redesigned foot stand  Pre-installed  Pre-installed  9  9
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 Digital Line Cards

 The MCA can be equipped on Meridian Digital Telephones on the following equipment:

• Enhanced Peripheral Equipment (EPE) with QPC578 line card

• Intelligent Peripheral Equipment (IPS) with the NT8D02 line card.

Power

The MCA requires the use of the new ATA/MCA Transformer (A0688664) for external, local power.

Note:  The NT2K69AA version of MCA cannot be supported with closet power sources such as Schumway.

Meridian 1 Software

The MCA requires X11 Release 14 or higher software for Meridian 1 Option 11 through 81C.  See the Meridian
1 System Administrator for additional details.

Telephone Foot stand

Meridian Digital Telephones manufactured after February 6, 1998 are equipped with MCA compatible foot
stands.  These sets show a Warranty Start Date code of 05/06/98 or later on the telephone set label.  These sets
also have the required jumper.

Figure 5  Telephone set label with required Warranty Start Date

Note:  For telephones manufactured before February 6, 1998, the foot stand will have to be replaced with the
MCA compatible foot stand.  These sets also require the installation of a jumper inside the telephone.  Refer to
Appendix B for additional information on phones that do not have the MCA compatible foot stand.
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MCA Installation

The Meridian Communications Adapter (MCA) allows personal computers to connect to the Meridian Modular
(Digital) Telephone, using an RS-232 connector.

The MCA installation consists of preparing the telephone for the MCA installation, installing the MCA, and
connecting the telephone to your PC.  When these steps are completed, proceed to the “Configuring the MCA”
section.

Caution:  Before handling internal set components, static electricity must be discharged by touching any
grounded metal surface.

Ensure the minimum requirements are met.  Refer to the “Requirements for the MCA” section located in this
chapter.

Note: Do not wall mount a telephone with MCA installed.
The wall mount knockout located on the bottom of the telephone foot stand must be in place. If this knockout is
damaged or missing you must replace the foot stand with a new one before installing the MCA.

Preparing the Telephone for MCA Installation

To Prepare the Telephone for the MCA Installation:

1. Disconnect and remove all cords (including the handset cord) from the telephone.

2. Place the telephone, upside-down, on a padded level surface.

3. Remove the two screws that connect the foot stand to the telephone base.

4. If you have the NT9K or NT2K telephone (Warranty date code of May 6, 1998 or later):

a. Remove and set the foot stand aside (you will reattach this foot stand onto the telephone base after
the MCA is installed).

b. Proceed to the “Installing the MCA” section below.

Or
If you have the NTZK or NT2K telephone (date code prior to May 6, 1998), refer to Appendix B for
additional information.

Installing the MCA

To Install the MCA:

1. Install the MCA in the foot stand:

a. Tilt the MCA PC board so that the DB-25 connector fits into the break-out section.

b. Lower the board into position on the bottom of the foot stand.

c. Secure the board using the two screws provided.
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2. Install the Jumper board on the 2X7 pin connector.

a. If a Power Supply board was not installed on the NTZK or NT2K, then there are 2 Jumper plugs
on the 2X7 pin connector.

b. Remove the 2 Jumper plugs before installing the Jumper board onto the 2X7 pin connector.

3. Plug one end of the short 8-conductor line cord, provided with the MCA, into the data jack in the base
of the telephone. Plug the other end of this cord into connector J1 on the MCA.

4. Reassemble the foot stand onto the base using the four screws you removed.

5. Reconnect all cords, including the handset cord and new 24Vwall transformer.

6. Locate the label that was included with the MCA, and place it on the telephone base close to the
existing set label for future tracking purposes.

7. You are now ready to connect your personal computer to your telephone.  Refer to the manufacturer
directions for installation instructions.

After you have installed the MCA, connect the telephone to your PC.

Connecting the Telephone to the PC

To Connect the Telephone to the PC:

1. Connect the MCA to one of the computer’s serial ports using a DB-25 to DB-25 (or DB-9) serial cable.

2. Connect the phone to the adapter in the phone jack with a standard phone cable.

You are ready to configure the MCA.  Refer to the “Configuring the MCA” for detailed information.
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Configuring the MCA

The Meridian Communications Adapter (MCA) is used to pass synchronous and asynchronous data through
Nortel Networks systems by using the Meridian Modular Telephone.  The following configuration must be
completed before installing and running the TAPI SP for MCA.  Refer to Appendix B for additional
configuration and MCA user information.

To Configure the MCA Using the Keypad:

1. Verify that the following:
The red LED at the rear of the telephone set is flashing.
The serial modem cable is installed between your PC COMM port (1-4) and the MCA.

2. Enter the following Program key sequences from your set:

a. Press the Program key on your telephone, enter 67, select Unlock, and press the Program key.
(Unlock the MCA)

b. Press the Program key, enter 65, and press the Program key. (Reset the MCA)
c. Press the Program key, enter 22, enter 2400 for the baud rate, and press the Program key.

(Change the baud rate)
d. Press the Program key, enter 20, and press the Program key. (Asynchronous mode)
e. Press the Program key, enter 34, and press the Program key. (Force DTR on)
f.  Press the Program key, enter 66, and press the Program key. (Select Modem emulation)

3.  Press the Program key, enter 67, select Lock, and press the Program key. (Lock MCA)

You are now ready to install the TAPI SP for MCA.  Proceed to Chapter 3.  Refer to Appendix B for
additional information on the MCA.
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Chapter 3  Installing the TAPI SP for MCA

This chapter provides instructions and information for installing The TAPI SP for MCA and includes the System
requirements and hardware configurations.

System Requirements for Installing the TAPI SP for MCA
Before you install and configure the TAPI SP for MCA, you should become familiar with the system hardware
and software requirements, hardware configuration and connectivity as described in this section.

Installation of the TAPI SP for MCA requires the hardware and software listed in the following sections.  Install
the required hardware and software before installing the service provider software.

Note:  Lower system speeds and lower memory capacities may adversely affect system performance.

Be sure to read the latest release notes and README.TXT files that came in your package before attempting to
install any software.

Minimum PC Hardware Requirements
The minimum hardware requirements for the TAPI SP for MCA include:

• 486/66 MHz
 16 MB of RAM is recommended.  Also check the application requirements.

The amount of memory needed by the TAPI SP for MCA to run is 196KB.  This increases as the
number of DNs and features assigned to the set increases, but is never more than 25%.

• The amount of free disk space that is needed for the TAPI SP for MCA is dependent upon which type
of installation you choose.  The Typical install requires 4 Mg of hard disk space.  The three types of
installation are as follows:
The install will ask you for the type of installation as follows:
- COMPACT - This installation will only install the Service Provider
- TYPICAL - This will install the Service Provider and associated diagnostic utilities as well as the
online documentation
- CUSTOM  - This will allow you to install only the components you choose.

Additional free disk space is required for running TAPI applications.  Refer to the appropriate TAPI
application document for information regarding additional disk space needed for the application

• Mouse (optional, but strongly recommended for installation)
• COMM 1, COMM 2, COMM 3, or COMM 4 available
• VGA or SVGA display
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 Minimum PC Software Requirements

 The minimum software requirements for the TAPI SP for MCA include:

• Windows NT 4.0  Service Pack 3 / Service Pack 4
• Windows 2000
• Windows 95 -  using Microsoft TAPI SP 2.1 software
• Windows 98

 Interface Devices
• Meridian Communications Adapter (MCA - NT2K69AA), for use on M1 options 11-81 with all cables

and power supply.

 Cables
• NT5P41AP PC Serial/Modem Cable or VISIT Interface Unit Cable (DB-9/DB-25)

 Configuring the PBX and Switch Equipment

 The following sections provide the configuration information needed to install the TAPI SP for MCA on the M1
Option 11-81 PBX.

 Configuring the Meridian 1/SL-1 PBX

 This section describes and illustrates the components needed for the installation of the TAPI SP for MCA on M1
Option 11C to 81C PBXs with X11, R22, R23, and R24.  Included are the necessary software releases, line
cards, telephones, and interface devices supported.  Required cabling is also listed.  A sample M1 Option 11-81
telephone set configuration is provided.

 Software Releases
 The software release required:

• for Meridian SL-1 -- X11 Release 14 or greater

• for Meridian 1 Option 11 --  X11 Release 16 or greater

• for Meridian 1 Option 21-81  -- X11 Release 15 or greater

 Line Cards
 One of the following line cards is required.

• NT8D02AB and above Digital line card in an IPE module

• QPC578 Digital line card in a PE module
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 Telephones Supported
 The following Meridian Modular Telephones are supported:

• M2006
• M2008
• M2216ACD-1
• M2216ACD-2
• M2616

 The following Orion Telephones are supported only in Europe:

• M3110
• M3310
• M3820

Figure 6  shows the TAPI SP components on Meridian 1 Option 11-81.

Figure 6  TAPI SP components on Meridian 1 Option 11-81
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Sample M1 Option 11-81 Telephone Set Configuration
Table 2 lists telephone set configuration information required for Meridian 1 Option 11-81 PBXs.  Use this
sample configuration when adding a new M2006, M2008, M2216 ACD or M2616 Meridian Modular Telephone
(MMT) or a M3110, M3310, M3820 Orion set.

Table 2  Sample M1 Option 11-81 telephone set configuration

LD 11
REQ NEW
TYPE 2006, 2008, 2216 or 2616
TN L S C U (Terminal number for set)
DES Designation
AOM <cr>

<cr>
.
.

RNPG 0
CLS CNDA, DNDA, ADD,

<cr>
.
.

KEY 0 SCR Voice DN (for dialing out and receiving calls)
KEY xx SCR Optional Voice DN
KEY xx DSP (must be configured to support delivery to TAPI application of Calling/Called

number on incoming calls to DNs on Keys 1 or higher before answering the
call)

KEY xx TRN (Call Transfer)
KEY xx AO3 or AO6 (AO3 supports 3 party conference;  AO6 supports 6 party conference)
KEY
KEY
KEY
KEY

If the telephone set is an ACD Agent set, configure the set as indicated in Table 2 with the exceptions and
additions listed in Table 3.

Table 3  ACD Agent set exceptions to Table 2

CLS CNDA, DNDA, ADD, AGN
KEY xx ACD xxxx yyyy

where:
xx = key number (must be key 0) (In- Calls Key)
xxxx = ACD DN
yyyy = Agent's position ID

KEY xx SCR DN (For dialing out and receiving calls)
KEY
KEY
KEY
KEY

Note:  In Load 95, the CPND must be set up in the switch.

The following instructions apply to the configuration in Table 3.

1. Use LD 95 to assign a name to the DNs on this set.  The names will be presented to the TAPI
application if allowed.

2. Use LD 23 to configure ACD Queues and enable Call Forcing for ACD sets (Refer to Meridian 1 ACD
documentation for details).

3. Make sure the Meridian 1 PBX is equipped to deliver ANI/CLID and/or DNIS to the telephone set to
support Screen Popping on ANI/CLID or DNIS.

4. TAPI applications cannot dial out on an In-Calls key.
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Refer to ACD Feature Description NTP 553-2671-110 or X11 features and services NTP 553-3001-305 for
additional information about Dialed Number Identification Service (DNIS).

 TAPI SP for MCA Software Installation

This section describes the procedures that must be performed to successfully install the TAPI SP for MCA.
Prior to installing this software, you must have certain hardware, software, and telecommunication
configurations in place.  These pre-installation configurations are detailed in the following checklist.

Pre-installation Checklist

Before installing the software, complete the following pre-installation checklist.

Note:  Install and configure the MCA before installing the TAPI SP for MCA 2.0 software.

1.  Uninstall any previous version of the TAPI SP for MCA.  It is important to remove the previous
version of TAPI software before upgrading to the new software.  Refer to the “Removing the TAPI SP
for MCA Software” section located in Chapter 6.  If you have Desktop TAPI 1.6 installed, you must
remove it using the Uninstall program located on the Desktop TAPI 1.6 installation CD ROM.  Refer
to the user’s documentation for the Desktop TAPI 1.6 for additional information..

2. Verify that your PC meets the minimum hardware and software requirements defined in the "System
Requirements for Installing the TAPI SP for MCA" section in this chapter.

3. Verify that your telephone type is one of the supported telephones listed in the “Desktop TAPI SP for
MCA System Requirements” section in this chapter.

If your telephone is an M2006, M2008, M2216 ACD set, M2616 set, or an M3110, M3310, M3820
Orion set, the Meridian 1 Option 11-81 PBX Administrator must configure the telephone set so the set
will work with your TAPI application.

4. Verify that your MMT telephone set is operational and has at least one DN key to support dialing and
answering calls from the TAPI application.

Determine which telephone features your TAPI application will need to use, then verify that these
features are assigned to your set.  You can examine the feature keys on your telephone set or use the
sample telephone set configuration printouts in this chapter as a reference while working with your
telephone system administrator to verify that your phone is set up properly to support your TAPI
application.

5. Verify that the telephone system to which your phone is connected is one of the configurations listed in
the " TAPI SP for MCA System Requirements" section in this chapter.

6. In Table 4, 5, and 6 circle the device type, telephone type, and the COMM port on the PC you will be
using.

Table 4  Device type

Interface Device: MCA
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Table 5  Phone Type

Telephone Type Models

Meridian Modular
(MMT)

Orion

M2006
M2008 M2216
M2616

M3110
M3310
M3820

Table 6  COMM port

PC COMM Port COMM 1 COMM 2 COMM 3 COMM 4

7. Fill in the three parts of Table 7 to record the directory numbers (DNs) that appear on your telephone
set and to record the ACD DN and Position ID for the In-Calls Key for ACD sets.  You may want to
use names that your telephone system has already associated with the DNs.  These descriptions will be
used when you configure your telephone using the Telephony icon in the Control Panel window.

Table 7  Directory Numbers (DNs) on your set

Key Telephone DN Name

Key ADC DN Position ID Name
0

8. If your telephone is equipped with an MCA, ensure it is correctly installed and verify the following
configuration has been completed (refer to Chapter 2 for detailed MCA installation and configuration
information):
- The red LED at the rear of the telephone set is flashing.
- The serial modem cable is installed between your PC COMM port (1, 2, 3, or 4) and the MCA
- Enter the following Program key sequences from your set:

a. Press the Program key on your telephone, enter 67, select Unlock, and press the Program
key. (Unlock the MCA)

b. Press the Program key, enter 65, and press the Program key. (Reset the MCA)
c. Press the Program key, enter 22, enter 2400 for the baud rate, and press the Program key.

(Change the baud rate)
d. Press the Program key, enter 20, and press the Program key. (Asynchronous mode)
e. Press the Program key, enter 34, and press the Program key. (Force DTR on)
f.  Press the Program key, enter 66, and press the Program key.(Select Modem emulation)
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Cautions and Preparations

The installation process includes only the installation of the TAPI SP for MCA.  The TAPI SP for MCA must be
installed first and your phone configured before installing any TAPI applications, as described in the following
procedures.

Note: Refer to the README.TXT file provided with the TAPI SP for MCA software before continuing.

This service provider is designed to run with TAPI 2.0 and above.  In order to run this on Windows 95, you
must install the TAPI Service Provider Service Pack available from Microsoft.  The Microsoft TAPI 2.1 files
are found on Microsoft’s web page (www.Microsoft.com).

For Windows NT, you must be logged in as Administrator or an account with Administrator rights to install the
TAPI SP for MCA and to add this Service Provider to the Windows Telephony configuration.

Installing the TAPI SP for MCA Software

The TAPI SP for MCA software is available in a variety of packages as indicated in
Chapter 1.  It is normally delivered via CD-ROM.  If applicable, refer to the user documentation provided with
your application for special instructions on loading the TAPI SP software in conjunction with the application.

The Symposium Desktop TAPI SP 2.0 for MCA CD-ROM contains three folders as follows:

• TAPISP16 Symposium Desktop TAPI SP version 1.6 and on-line documents (Refer to the Desktop TAPI
SP 1.6 documentation for detailed installation and configuration instructions)

• TAPISP20 Symposium Desktop TAPI SP for MCA version 2.0 software

• Docs On-line documents for the Symposium Desktop TAPI SP for MCA version 2.0

There are three types of installation offered, Typical, Compact, and Custom.  The Typical installation installs the
software, the online documentation, and the troubleshooting tools.  The Compact installs only the Symposium
TAPI MCA 2.0 software.  The Custom allows you to select the components you wish to install.  If the online
document is installed, it is displayed in the Desktop TAPI SP for MCA program group.

Prior to installing the TAPI SP for MCA software, ensure the Pre-installation checklist (located in the “Pre-
installation checklist” section in this chapter) is complete.

Note:  If you have a previous version of the Symposium TAPI MCA installed, remove the previous version
before installing this software.  If necessary, refer to the “Removing the TAPI SP for MCA Software” section
located in Chapter 6.

If you have the Desktop TAPI SP 1.6 software installed, you must use the Uninstall option located on the
installation CD.  Refer to the Desktop TAPI SP 1.6 User’s Guide for detailed information on uninstalling the
software.

Instructions are provided for installing the TAPI SP for MCA from a CD ROM only.

Note:  Before starting the TAPI SP for MCA software installation, close any TAPI applications that are
running.
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To Install the TAPI SP for MCA Software:
1.  Insert the Desktop TAPI SP for MCA CD ROM that contains the TAPI SP for MCA installation

software in the CD ROM drive.

2.  Click on the Start button and Select Run.
The Run dialog box is displayed.

3. Type the path for the CD ROM followed by \TAPISP20\setup.exe in the Run dialog box.
For example:  
E:\TAPISP20\Setup.exe

4. Click on the OK  button.
The installation process begins.

The Welcome dialog box is displayed:

5. After reading the information on the Welcome screen, click on the Next button to continue the
installation.
The Software License Agreement dialog box is displayed.
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6.  Read the License Agreement and click on the Yes button to accept the terms of the License agreement
and continue the installation.
Or
Click on the No button to cancel the installation.

7.  If you clicked on the Yes button, the Information dialog box appears.

8.  Click on the Next button to display the User Information dialog box.

9.  Enter your Name and Company name in the fields provided.
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10.  Click on the Next button to display the Choose Destination Location dialog box.

11.  Click on the Next button to accept the default directory and to display the Setup Type dialog box.
Or
Click on the Browse… button and enter or select a new path name. The drive in the path name must
have Windows 95 or Windows NT installed.

a.  Click on the OK  button to close the dialog box and display the Choose Destination Location
dialog box.

b.  Click on the Next button to display the Setup Type dialog box.
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8. Accept the default Typical installation if you want the software, documentation, and
Troubleshooting tools installed.  Click on the Next button to display the Select Program Folder.
Or
Click in the radio button to select the type of setup you prefer.  Select the Compact option if you
want to install only the TAPI MCA 2.0 software or the Custom option if you want to select which
components will be installed.  Click on the Next button to display the Select Program Folder
dialog box.
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9. Click on the Next button to accept the default Program Folder name to display the Check Setup
Information dialog box.
Or
Enter or select a new Program Folder name and click Next button to display the Check Setup
Information dialog box.

10. Check the information and ensure it is correct.  Clicking on the Back button allows you to view the
previous screens and correct any incorrect information.  When the information is correct, click on the
Next button to install the files.

The Setup dialog box displays the files that are being installed.

The Setup Complete screen notifies you when the installation is complete.
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11.  Click on the Finish button.  The Readme.txt information is displayed.

12. Read the Readme.txt file then close the window to complete the installation.

13. Remove the CD ROM or diskette from the drive.

14. Click on the Start button, select Programs/ Desktop TAPI SP for MCA to verify that the Desktop
TAPI SP for MCA  program group contains the following icons:
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You are now ready to configure the TAPI SP for MCA 2.0.

Refer to Chapter 4 for detailed instructions on configuring the TAPI SP for MCA software .  Refer to Chapter 6
for detailed information on using the JulMar TAPI Phone Dialer and the TAPI Logger.
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Chapter 4 Configuring the TAPI SP for MCA
Software

This chapter provides information on configuring the TAPI SP for MCA 2.0.

Overview of the Configuration Process

The Symposium Desktop TAPI Service Provider 2.0 for MCA (TAPI SP for MCA) enables TAPI compliant
applications to communicate calling information and other commands to and from applications. Before installing
TAPI applications, you must configure the TAPI SP for MCA.  Certain configurations require you to restart
Windows to enable the changes.

Note:  The dialog boxes shown in this section are examples of Windows 95 dialog boxes.  If you have Windows
NT, the dialog boxes you see may vary.  However, the information on Windows 95 and Windows NT dialog
boxes are the same.

Steps for Configuring the TAPI SP for MCA

Configuration options are selected from the Nortel TAPI SP Setup dialog box.  Configuring the TAPI SP for
MCA consists of the following steps:

1. Access the Dialing Properties dialog box.  Close all applications that use TAPI.

2. Add the Desktop TAPI Service Provider Driver to the Windows Telephony configuration.

3. Add a new line.

4.  Confirm the MCA Device is setup properly.

5.  Configure the DNs and Addresses.

6.  View or change the configuration.

The following sections provide instructions for each step.

Note:  This service provider is designed to run with TAPI 2.0 and above.  In order to run this on Windows 95,
you must install the Microsoft TAPI Service Provider 2.1 upgrade available from Microsoft.

For Windows NT, you must be logged in as Administrator or an account with Administrator rights to install the
TAPI SP for MCA and to add this Service Provider to the Windows Telephony configuration.  However, the
configuration can be done as a user.  The TAPI SP for MCA applications and diagnostic utilities can be used by
users.
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Accessing the Dialing Properties Dialog Box

To Access the Dialing Properties Dialog Box:

1. After installing the TAPI SP for MCA software and restarting Windows, click on the Start button and
select Settings.

2.  Double-click on the Control Panel icon.

The Control Panel window displays the Telephony icon .

Note:  If the Telephony icon does not display (in Windows 95) after installing the TAPI SP for MCA
software, you must install the Windows Telephony Dialer software.  This is found on your Windows 95
CD ROM.

3. Double-click on the Telephony icon.

The Telephony Drivers tab page located on the Dialing Properties dialog box displays a list of
Installed Drivers on the left side.
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Adding the Desktop TAPI SP for MCA Driver

To Add the Desktop TAPI SP for MCA Driver:

1. From the Telephony Drivers tab page located on the Dialing Properties dialog box, click on the Add
button.  The Add Driver dialog box displays the Telephony Drivers list containing the Desktop TAPI
SP for MCA.

2.  Click on Desktop TAPI SP for MCA to highlight it.

3.  Click on the Add button.
The Nortel Service Provider for MCA is displayed on the Telephony Drivers tab page located on the
Dialing Properties dialog box.

Adding a New Line

To Add a New Line:

1.  From the Telephony Drivers tab page located on the Dialing Properties dialog box, select the Desktop
TAPI SP for MCA, if not highlighted.

2.  Click on the Configure button.
The Desktop TAPI Service Provider for MCA dialog box is displayed.

3.  Click on New to add a new line device.
The Device dialog box is displayed.
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4.  Enter the Name of the Device in the Name for this Device field.  TAPI will use this to identify the line.
A commonly used name is “MCA.”

5.  Click the Next button.  The Device dialog box appears; allowing you to select a COMM Port.

6.  Click on the down arrow located to the right of the Communication Port field to select the COMM port
to which the MCA is connected.

7.  Click on the Finish button to save the configuration.  The MCATSP.TSP information dialog box is
displayed.
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8.  Click OK.  The Desktop TAPI Service Provider for MCA dialog box displays the Device Name,
COMM Port and the status of the MCA as New.

9.  Click Close to close this dialog box.

Note:  You must exit the Control Panel and reenter or start the TAPI application to see the line that was added
and update the status from “New” to “OK.”  Refer to the “Confirming the MCA Device is Setup Properly”
section for additional information.
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Confirming the MCA Device is Setup Properly

To Confirm the Device is Setup Properly:

1.  Access the Control Panel and double click on the Telephony icon to reinitialize the driver.
It may take a few seconds for the Dialing Properties dialog box to appear but when it does, click on the
Telephony Drivers tab to display all of the TAPI Service Providers installed on your PC.

2.  Select the Desktop TAPI SP for MCA (if not highlighted) and click on the Configure button.
The Desktop TAPI Service Provider for MCA dialog box displays the Status of the MCA.

3.  Ensure the status of the device is now “OK.”

Note: If the status is “Fail”, click the Details button to display the Diagnostics dialog box, then check the items
suggested and also quit all TAPI applications that are running.  If the status still shows “Fail” it may be
necessary to reboot your PC.  If after rebooting your PC, you still receive a “Fail” status, refer to the “Desktop
TAPI SP for MCA Fails” section located in Chapter 6 for additional information.
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Configuring the DNs and Addresses:

To Configure the DNs and Addresses:

1.  Ensure the status of the MCA Device is “OK” on the Desktop TAPI Service Provider for MCA dialog
box.  Refer to the “Confirming the MCA Device is Setup Properly” section for additional information.

2.  Click on the Details button.
The MCA Config dialog box is displayed.

3.  Click on the DNs/Addresses tab to view the DN's.  This tab page also allows you to assign a Name and
Number for each address.

To Assign a Name and Number for each address:
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a.  Double click on the Key number you wish to change.
The Configuring Key dialog box is displayed.

b.  Enter the Number (DN) of the address and the Name of the line. The Name can be any
alphanumeric characters (maximum of 20 characters).  Typically, you will enter the numeric DN or
ACD DN for this key in the number field, and a name you would like to associate with this key in
the name field.  You may want to use the same name that is configured on the switch for this DN.

c. Click on the OK  button to save the configuration.
Or
Click on the Cancel button to cancel the configuration.  The MCA Config dialog box is displayed
with the new name and number information displayed for the key.

4. Click on the Apply  button then the OK  button to save the configuration.
The following information box is displayed.

5.  Click on the OK  button.

Note:  You must exit the Control Panel and reenter or restart the TAPI application for the changes to take effect.
Refer to the “Confirming the MCA Device is Setup Properly” section for additional information.

Viewing and Changing the MCA Configuration

To View and Change the MCA Configuration:

1.  Ensure the status of the MCA Device is “OK” on the Desktop TAPI Service Provider for MCA dialog
box.  Refer to the “Confirming the MCA Device is Setup Properly” section for additional information.

2.  Click on the Details button.
The MCA Config dialog box is displayed.
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You have the capability to rename the device, but if you want to select a new COMM Port, you must
first remove the device, then add a new one.  If changes are made, you must exit the Control Panel and
reenter or restart any TAPI applications that are running before the changes will take effect. Refer to
the  “Confirming the MCA Device is Setup Properly” section for additional information.

3.  Click on the Features tab to display the list of supported features.
This is a “view only” dialog box.
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4.  Click on the Options tab to display the Options tab page.

This dialog box allows you to select to have the Display key activated by the driver (when checked) or
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activated by the user (when checkbox is blank).
The Reverse Lamp Flash is only applicable in the European markets.

5.  Click on the Advanced tab to display the Advanced dialog box.

The Advanced page allows you to change the reason codes being used by the Meridian 1 PBX.

Note:  These codes must match the information provided in Load 95 of the Meridian 1 switch otherwise
the Caller ID and Called ID information may be displayed in your application incorrectly.

6.  Click on the Driver Info  tab to display the Driver Info dialog box.
This dialog box displays the version of the TAPI SP for MCA that is currently being used.

7.  When changes are complete, click on the OK  or the Apply  button.
The following information box is displayed.

8.  Click on the OK  button.

Note:  You must exit the Control Panel and reenter or start the TAPI application for the changes to take effect.
Refer to the  “Confirming the MCA Device is Setup Properly” section for additional information.
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Chapter 5  Getting Results

By installing and configuring the MCA and the TAPI SP for MCA, you have Computer Telephony enabled your
desktop.  This chapter provides information on some of the applications that take advantage of the new
telephony services that this gives you and that help you become even more productive than you already are.

Overview to the Desktop CTI Enabler
The following sections describe how you can use your new Symposium TAPI MCA to help you become more
effective at completing your daily tasks.  For example, after installing the MCA and the TAPI SP for MCA, you
can setup and use:

• Applications that are part of your Windows Operating System, including the Phone Dialer that allows you
to place calls directly from a speed dial list without having to touch your phone.

• The Phone Dialer telephony features of Microsoft's Outlook 97/98 and Microsoft Schedule+  to place calls
directly from the Contacts List.

• Nortel TAPI applications such as Symposium Call Manager to manage your personal calls.

• TAPI Applications from Nortel's Business Affiliates or Symposium Partners and other vendors.

Using the Phone Dialer Application

The Phone Dialer is a simple TAPI Application that comes with all versions of Windows.  It makes simple phone calls,
speed dials, and outpulses digits.

Setting up the Phone Dialer

Setting up the Phone Dialer Applications consists of accessing the Phone Dialer window and entering
information on the Connect Using dialog box.

To Set up the Phone Dialer Application:

1.  Click on Start button and go to Programs / Accessories.

2.  Select Phone Dialer.
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The Phone Dialer window opens.

3. Click on Tools and select the Connect Using option.

The Connect Using dialog box is displayed.

4. Click on the drop-down arrow located to the end of the Line field and select your line name.

5.  Click OK  to close the Connect Using dialog box and save the changes.

Using the Phone Dialer

After setting up the Phone Dialog application, you are ready to make a call using the Phone Dialer and to
configure the Speed dial button(s).  The Speed dial buttons allow you to pre-program numbers, so that simply
clicking on a button places the call.
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To make a Call:

1.  From the Phone Dialog dialog box, enter digits in the Number to dial field.

2.  Click on the Dial button.
The call is dialed.

To Configure a Speed Dial Button:

1.  Click on the Speed dial button you wish to configure.
The Program Speed Dial dialog box is displayed.

2.  Enter a Name for the button in the Name field and the number associated with the name in the
Number to dial field.

3.  Click on the Save button to save the information.
The information is displayed on the Phone Dialer window.

4.  Program additional buttons by repeating steps 1-3.
The configured buttons display the names you entered.

Additional information regarding this application can be found by clicking on the Help option located on the
Menu bar.
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Using the Phone Dialer Features of Outlook 97/98 and
Microsoft Schedule+

Microsoft Outlook 97/98

If you have Microsoft Outlook 97 version 8.02.4212 or above loaded on your machine, you can use it with the
Symposium TAPI MCA.  In addition, the Symposium TAPI MCA does not provide the Microsoft Outlook 97
software.  This software is located on Microsoft’s Web site.

The information presented here is for general purposes only and intended only as a guide in using Microsoft
Outlook 97 with the Symposium TAPI MCA.  For specific Microsoft Outlook 97 information, refer to Microsoft
Outlook 97 user documentation.

Setting up Outlook 97/98 to Allow Dialing from the Contacts List
To Setup Outlook 97/98:

1. Ensure the Symposium TAPI MCA software in installed, configured, and working and that Microsoft
Outlook 97/98 is loaded on your machine.

2. From the Contact folder, go to the Tools menu and select Option.
The Options dialog box is displayed.

3. Click on the Dialing Option…  button.
The Dialing Options dialog box is displayed.
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4. Click on the arrow located to the right of the Connect using line drop down list box to display the
options.

5. Select your TAPI line instead of the modem.

6. Make any additional changes to the Dialing Properties as desired.

7. Click on the OK  button to save the changes and close the Dialing Options dialog box.

Using Outlook 97/98 to Allow Dialing from the Contacts List
After setting up Microsoft Outlook 97/98, you can now dial from the Contacts.

1. Click on Tools located on the Menu bar and select the Dial / New Call option or right click on a
Contact and use the autodialer.

2. Click on the Start Call  button to place your call.
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Using Nortel Symposium Call Manager Application

Nortel Symposium Call Manager provides call management from your PC with a Windows-based graphical user interface
(GUI) that operates with the Symposium TAPI MCA.  The call management options allow you to place and answer voice
calls, put voice calls on hold, forward, or transfer calls, and redial a previous number.  Setting the Call Manager
preferences tailors the Call Manager features to suit your specific needs.  In addition to call management, the Call
Manager application provides access to the Call Log, Voice Mail, and Dialing Plans applications.  The Call Manager
application must be active for the Call Log application to log calls.

Accessing Call Manager opens the Call Manager window.  The Call Manager window can be viewed in two different
modes, expanded and collapsed.  The expanded view displays the categories and members' names from the Directory
application.

Call Manager also works in conjunction with the Directory application.  Call Manager allows you to display the directory
categories and members.  New categories and members can be added, edited and deleted from the Call Manager window.

Setting the Call Manager Preferences

Setting the Call Manager preferences tailors the Call Manager features to suit your specific needs. Preferences
are set on the Settings dialog box and include the following steps:

• Access the Settings dialog box.

• Set the General Settings

• Set the Sound Preferences

• Set the Incoming Preferences

• Set the Call Log Preferences

• Save the changes and close the Setting dialog box.

 Selecting the Settings option on the Tools menu or selecting the Settings... icon  displays the Settings
dialog box.

To Set the Call Manager Preferences:

1. Access the Call Manager application.

a. Click on the Start button , select Programs/Nortel Symposium.
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Note: The applications that are displayed on your desktop depend upon the installed Nortel Symposium
products.

b.  Select Call Manager.

The Call Manager main window opens.

2. Click on the Setting button  located on the Toolbar.
Or
Click on Tools, located on the Menu bar of the Call Manager window and select Settings.
The Settings dialog box is displayed
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Using Symposium Call Manager to Place a Call

To Place a Voice Call:

If you have not created your Directory database or created a Dialing Plan for your location:

Type the number exactly as it is to be dialed in the Number field.

Call Manager dials the number contained in the Number field.
Or

Click on the Dial keypad icon  on the toolbar bar.  The Keypad is displayed.  Click on the
numbers to place the call.

If you have created your Directory database and created a Dialing Plan for your location:

1. Ensure the correct dialing plan is active.  (Access the Dialing Plan application and select the dialing
plan created for your location.)

2. Select the member you wish to call.

a. Expand the Call Manager window, if necessary by clicking on the Directory icon.

b. Select the Category that contains the name of the person you want to call by clicking on it.

c. Select the name of the person in the Members listbox to call by clicking on it.
The Name and Number fields display the selected name and telephone number.  The selected name
is highlighted in the Name listbox.

3. Double-click on the highlighted name.
Or
Click on the Telephone icon located on the Toolbar.
Or
Double-click on the telephone icon, located in the Call Status area, that represents the line you want to
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use to place an outgoing call.
Or
Click on Features located on the Menu bar.
The Features menu is displayed.  Click on Call.

Call Manager dials the number contained in the Number field.

Using the Call Log

The Call Log application is provided with Nortel Symposium Call Manager and keeps a log of all incoming and
outgoing voice calls according to the preferences you set.  Setting the Call Log preferences logs the type of calls
you desire.

Accessing the Call Log application does not automatically log your calls.  The Call Manager application must be
active for your calls to be logged by the Call Log application.  Once the Call Manager is running, accessing the
Call Log application from the Navigator, from the Nortel Symposium program group, or from the Call Manager
application launches the Call Log application.  Placing a call from the Call Manager window launches the Call
Log application.

However, the Call Log window does not open until the Call Log option on the Call Manager Tools menu is
selected.

Placing a Call from the Call Log

To Place a Call from the Call Log:

1. Access the Call Log by selecting the Call Log option on the on the Call Manager Tools menu .
The Call Log window opens.
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2. Double-click on the entry (line) containing the number you wish to call.
Or
Click on the entry (line) containing the number you wish to call to select it.

Click on the Make a Call button  located on the Toolbar.
Or
Click on Tools located on the Menu bar.

The Tools menu displays the menu options.

Click on the Make Call option.

The selected entry number is dialed.
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Using the FastView 1.6 Application

FastView 1.6 is another TAPI Application available from Nortel Networks that is intended for use primarily in Call
Centers and Help desks.  FastView allows you place outbound calls, answer incoming calls, and hold, unhold, transfer
and conference calls.  It provides a screen pop on the CLID or DNIS of an incoming call quickly and without user
intervention.

Setting up FastView 1.6

To Set up FastView 1.6 to use the Symposium TAPI MCA:

1. Start FastView Administration to display the main window.

2.  Click on the Configure dragdown and select Telephone Parameters.
The Telephony Parameters dialog box is displayed.

3.  Select Nortel Service Provider for MCA in the TAPI Device drop-down box.

Using FastView 1.6

You can use FastView to do call control using simple User Interface buttons.

Note:  Login / Logout / ACD Ready and Not Ready are not supported at this time.

The features of FastView used with the Symposium TAPI MCA include the following: Make Call, Answer Call,
Hold, Unhold, Transfer, and Conference as demonstrated with the FastView user interface below
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.

Using Other TAPI Applications

Your new Symposium TAPI MCA supports many TAPI Applications.  The following section lists some that
have been tested and highlights the key tasks to perform with each application that will help you in becoming
more effective at performing your daily tasks.

Using the ActiveVoice PhoneMax 2.0 Application

PhoneMax is Active Voice's first standalone telephony product.  It gives TAPI users complete control over all
telephone activity right from their PC! With an integrated Call Log and PIM (Personal Information Manager), it
also enables you to use information from personal databases and other applications with every call.

Setting up PhoneMax 2.0
To Setup PhoneMax 2.0 to be used with the Symposium TAPI MCA:

1. After starting the PhoneMax Application, click on the Setup button on the active window.

2. Click on the TAPI  radio button

3. Use the down arrow located to the right of the Name field and select your TAPI Line Name.
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4. Click OK  two times to save the changes and close the dialog box.

Using PhoneMax 2.0
The figure below shows a sample user interface for the PhoneMax 2.0 application.  Refer to the PhoneMax 2.0
User Guide for details.
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Using the Revolution Rapport for TAPI Application

Rapport for TAPI is a revolutionary Desktop Telephony Interface designed to seamlessly integrate telephony
control into the users 32 bit desktop environment.  Rapport allows you to control your telephone activity directly
from your PC while leaving you in control at all times. Highlights of this application are: Call Control (answer,
hold, transfer, unhold, conference), Integrates with your existing applications, Telephony Enable your entire
Windows Environment, Hotkey Control, Caller ID integration, Non-intrusive call handling metaphor,
Revolutionary interface

Setting up Rapport
To Set Up Rapport to be Used with your Symposium TAPI MCA:

Refer to the Rapport for TAPI User Guide for procedures on how to configure which line appearances you
want the application to control.
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Using the Algo Communications PC Phone Application

The figure below shows another type of user interface you might like that can be used with the Symposium
TAPI MCA.  Refer to the PC Phone User Guide for procedures on how to configure the line appearances you
want the application to control.
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Using the Amicus Attorney 3.0 Application

Amicus Attorney is a TAPI application designed for Law offices to make calls, answer calls, hold and unhold
calls, outpulse digits, time calls, and log calls.

Setting up Amicus Attorney
To Setup Amicus Attorney to be used with your Symposium TAPI MCA:

1.  Access the Amicus Attorney main window.

2.  Click on File and select Setup.

3. Click on the Phone Tab to display the Phone Call Management options.

4. Setup your Telephony Line/Device and address.

5. Click on the OK button.

Using Amicus Attorney
To Use Amicus Attorney:

1. From the main window, click on the Phone icon in the lower right corner of the window.

2. Either select an address entry or enter a new number in the Phone field.
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3. Click on the Phone icon to make a call.

You can use the Stop / Clock icon to time the call.

To view the log:

Click on Show Log button.
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Chapter 6  Troubleshooting Tips

This chapter provides information for additional installation acceptance testing using the JulMar TAPI Phone
Dialer tool and for running the Logger Tool.  In addition, it also describes possible problems and the actions to
resolve these problems.

MCA Troubleshooting

MCA does not Operate at All

1. Check the LED in the back of the telephone to see if it is flashing. If the LED is steadily lit, the MCA
needs to be configured in your system, or it may be bad. If the LED is not lit, the MCA requires
external power.

2. Make sure the cable from your terminal or PC is connected to the MCA.

3. Check the data parameters for your display.

4. Be sure the transformer is plugged in, or the closet power is connected.

5. Be sure the cable between the MCA and your telephone is connected and has not been pinched.

6. Be sure the power card is installed correctly. Verify the jumper settings are correct for either RS-232 or
V.35 (whichever you are using).

If the problem persists, you may need to troubleshoot your telephone.  Refer to Meridian Modular
Telephones description (553-2201-116) or Telephone and attendant console installation (553-3001-
215).

Notes: If pseudo random pattern 511 data is sent in idle mode (when there is no active call), telephone keypad
dialing is inoperative. Stop sending the data from the DTE.

If using an RS-232 cable to connect the MCA to an ADM3/5 terminal, be sure pin 22 is disconnected.

Change the baud rate before you change the mode from synchronous to asynchronous.

Some terminals may drop DTR with the break. If this happens, RELEASED is not displayed.

Program Auto Dial before VLL is selected.

The answering side's data module always adapts to the calling side's data module parameters. The
calling side's data module never adapts to the answering side's data module parameters.
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Modem pooling

No modem pooling is supported in synchronous mode.

Power failure

When a call is connected between two MCAs, power failure or removing the power from one MCA does not
release the call until the power is restored.

The MCA always retains the previous data parameters. There is no resetting required in the case of power
failure.

After the call is connected send the data using bit error rate testers (BERT). If there is no transmission or if there
are excessive errors, the MCA is probably defective. Return it for repair.

Verifying the TAPI SP for MCA is Installed and
Configured Properly

The JulMar TAPI Phone Dialer tool is provided to assist you in verifying that the TAPI SP for MCA is properly
installed and configured.  Alternately, Microsoft “Dialer” application provided with Windows 95, can also be
used to dial a call and verify that the TAPI SP for MCA is up and running.

Note:  If you are having problems, you may be instructed to run the TAPI Logger program while using the
JulMar TAPI Phone Dialer tool.  The “Logger Troubleshooting Tool” section provides information on running
the TAPI Logger program.  However, do not run the TAPI Logger program unless instructed to by Nortel’s
TAPI Support Personnel.

Using the JulMar TAPI Phone Dialer

The TAPI Phone Dialer program from JulMar Technology Inc. is installed on your PC when you install the
TAPI SP for MCA version 2.0 software (unless you selected the Compact installation option).  This program
allows you to verify that the installation and configuration steps have been completed properly and determine
whether your PC is ready to support your Computer Telephony (TAPI 2.x compliant) application.  The TAPI
Phone Dialer Program icon is located in the Desktop TAPI SP for MCA program group.

Note:  The JulMar TAPI Phone Dialer is provided to Nortel Networks by JulMar, Inc.  Information and product
updates on the TAPI Phone Dialer are provided on the JulMar web site (www.JulMar.com).

Running the TAPI Phone Dialer program allows you to answer, make, and drop calls, to place calls on hold and
take them off hold, and to transfer and conference calls using the same methods your TAPI applications use.
The call information is displayed in fields and is useful when dealing with customer support.  The procedures
below describe how to use the TAPI Phone Dialer.
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To Use the TAPI Phone Dialer to verify the operation of the TAPI SP for MCA version 2.0:

1. Click on the Start button and select Programs\. Desktop TAPI SP for MCA.

2. Select the TAPI Phone Dialer program.
The TAPI Phone Dialer program window opens.

3. Click on the down arrow located next to the Device field and select the MCA device configured above.
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4. Click the down arrow located next to the Address field and select the DN you want to control/monitor.

5. Click on the Start Session  button.

6. Enter a dialable number in the Phone # field and click on the Make Call button.

Your phone should go off-hook and dial the number automatically.

7. After the far end answers, click on the Hold button.  The call is put on hold and the indicator beside the
DN on the set is flashing.

8. Click on the Unhold button.  The call is taken off hold and the indicator beside the DN key on the set
lights steady.

9. Click on the Hangup button.  The call will be disconnected.

10. From another telephone, place a call to your DN.  While the phone is ringing and after you answer the
call by clicking the Answer button, verify that the information is correct in the following fields: Call
State, Call Type, Call Direction, Caller ID, Called ID, Connected ID, and Redirecting ID.

Note:  The buttons are only available if you are able to perform the task from the set and the TAPI SP
for MCA supports the feature.  You are now ready to install , configure, and use your CTI
Applications.

11. Click on the End Session  button to close the TAPI Phone Dialer program window.

Logger Troubleshooting Tool

During installation or while running an application, problems may occur that cannot be easily found through
normal running of the application.  The Nortel Logger troubleshooting tool logs messages from the TAPI
Service Provider to assist in troubleshooting purposes.  To provide maximum help with troubleshooting, the
Nortel Logger provides message filtering functionality to determine which messages from the TAPI Service
Provider are displayed.  This tool also allows you to assign different colors to the messages to enhance the
message presentation in the Nortel Logger 32 window.  Accessing the Nortel Logger Troubleshooting Tool
opens the Nortel Logger 32 window.

Note:  You must setup the message filter parameters to determine how the logging messages are displayed
before the Nortel Logger will log the messages.

Setting up the message filter parameters consists of the following steps:

• Set up the Message Filter to display only the selected messages.

• Select and assign a color to each message type.
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 After the message filter parameters are set, the Nortel Logger logs messages to the display area on the Nortel
Logger 32 window according to the parameters you set.  When the Nortel Logger 32 window becomes full, the
messages are written to the Overflow file.  The Nortel Logger troubleshooting tool allows you to change the
Overflow file setup defaults.  Selecting Options located on the Settings menu displays the Options dialog box.
This dialog box provides fields to change the default Overflow file name, the pipe name, the maximum number
of displayed lines on the Nortel Logger 32 window, and the size of the Overflow file.

 If you want to Nortel Logger 32 window to occupy the topmost position on your desktop, the Nortel Logger
provides the option to keep the Nortel Logger 32 window on the top position on your desktop.

 After setting up the message filter parameters, the messages from the TAPI Service Provider are logged.

 The Nortel Logger tool allows you to perform the following tasks:

• Save the Nortel Logger display window’s content in an .RTF or .TXT file.

• Append the Nortel Logger display window’s current content to the Overflow file and clear the window.

• Clear the Overflow file.

• Print the Nortel Logger display window’s content.

• Close the current display window and open a new one.

• Open an existing file and display it in the Nortel Logger display window.

• Search for a particular string in the information displayed in the Nortel Logger display window.

Launching the Logger Troubleshooting Tool

Note:  Run this application only when requested to by the Desktop TAPI SP technical personnel.

The Logger Troubleshooting Tool is launched by clicking on the Start button, selecting Programs, then
selecting Desktop TAPI SP for MCA program group, and choosing Logger Utility .

Launching the Logger Troubleshooting Tool opens the main Logger window.  After launching the Logger,
starting a TAPI application, such as the JulMar TAPI Phone Dialer tool, displays information in the Nortel
Logger 32 window.
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Overview of the Nortel Logger 32  Window

The Nortel Logger Troubleshooting tool provides an easy to use Windows-based interface that is similar to
other Windows-based applications.  The Nortel Logger 32 window contains the following window elements:
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Nortel Logger 32 Window  Menu Options
The Nortel Logger window provides the following Menu options:

Menu Description

File Provides options for working with the message information.

Edit Provides standard windows editing options for working with the message information in the window
display area and provides a search feature for searching for a particular message.

View Provides viewing options for displaying or hiding the Toolbar and Status bar.

Settings Provides options for setting up the Overflow preferences and the message filter parameters.

Help Provides information about the Nortel Logger Troubleshooting tool.

File Menu

Option Description

New Allows you to close the current display window and open a new one.  If the current display
window is not empty, the Nortel Logger prompts you to save its content, which will be cleared
after the new display window is opened.

Open Allows you to open an existing file and display it in the Nortel Logger display window. There are
two types of file formats used by the Nortel Logger: RTF and TEXT.  Files with “rtf” are opened
as rich text edit format files to take full advantage of RTF.  Other files are open as text files.

Save Allows you to save the current Nortel Logger display window’s content to the currently opened
file. If the content is from a new file, the Nortel Logger prompts you for a file name.

Save As Saves the current content of the Nortel Logger display window to a file. The Nortel Logger
prompts you for a file name. There are two file formats used by the logger: RTF and TEXT. If the
given file name has an extension as “rtf”, the file will be saved as rich text edit format file.
Otherwise the file is saved as plain text file.

Note: Both Save and Save As commands only save the current content in the Nortel Logger
display window.

Append to overflow Appends the current content of the Nortel Logger display window to the overflow file and clears
the display window.

Clear overflow file Clears the overflow file.

Print Prints the current content of the Nortel Logger display window

Print Setup Displays the Print Setup dialog box for changing the printing parameters

Exit Closes the Nortel Logger 32 window and exits the Nortel Logger Troubleshooting tool
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Edit Menu

Option Description

Undo Allows you to undo the previous editing.

Cut Cuts the current selection in the Nortel Logger display window and puts it on the clipboard.

Copy Copies the current selection onto the clipboard.

Paste Pastes the current clipboard content into the Nortel Logger display window starting with the mouse
button cursor location.

Select All Selects all of the information content in the Nortel Logger display window.

Clear All Clears all of the information content in the Nortel Logger display window.

Find Displays the Find dialog box that allows you to search for a given string in the Nortel Logger display
window.  (Refer to the “Searching for a Particular String in the Logger Display Window” section for
more information.)

Find Next Searches for the next string, which is specified by the previous Find command, in the Nortel
Logger display window

Replace Replaces a found string with a given string as entered on the Replace dialog box.

View Menu

Option Description

Toolbar Toggles the Toolbar display.

Status Bar Toggles the Status bar display
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Settings Menu

Option Description

Options Provides the option to set up the overflow file name, the named pipe’s name string used by the Nortel
Logger, the maximum line number displayed in the Nortel Logger display window, the maximum size of
the overflow file, and to select to have the Nortel Logger 32 window on top.

Filter Provides the capability to set up the message filter to display only the selected messages.

Help Menu

Option Description

Help Topics Provides access to the on line help.

About Nortel Logger Displays the About dialog box, which has version and copyright information.

Changing the Topmost Position of the Nortel Logger 32 Window
The Options dialog box provides the option to keep the Nortel Logger 32 window in the topmost position on
your desktop.

To Have the Nortel Logger 32 window Always on Top

1.  From the Nortel Logger 32 window, click on Settings to display the Settings menu options.

2.  Click on the Options option.
The Options dialog box is displayed.
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3.  Click in the Logger window on top check box.
A check mark in the check box means the option is selected and the Nortel Logger 32 window now
occupies the topmost position on your desktop.

Setting Up the Parameters for the Message Filter

Setting up the message filter parameters consists of accessing the Nortel Logger window, setting up the Message
Filter to display only the selected messages, selecting and assigning a color to each message type, and setting up
the Overflow file name and properties.  Nortel Logger writes to the Overflow file when the number of lines in
the Nortel Logger 32 window reaches the user defined limit.

After setting up the message filter parameters, accessing the Nortel Logger opens the Nortel Logger 32 window
with the logging messages from the TAPI Service Provider are displayed according to the parameters you set.

Setting up the Message Filter
The message filter is required to be set up so that the desired message can be displayed on the Nortel Logger
display window.  Setting up the Message Filter consists of accessing the Filter Setup dialog box, adding the
categories, and adding message types to each category.  After creating the categories with message types, you
have the option to assign a color to each message type.

To Access the Filter Setup Dialog Box:

1.  From the Nortel Logger 32 window, click on Settings to display the Settings menu options.
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2.  Click on the Filter  option.
The Filter Setup dialog box is displayed.

To Add the Message Categories:

1. Right mouse click in the Filter Setup dialog box to display the menu options.

2.  Select the Add All  option to add all available categories.
Or
Click on the Category you wish to add.

Note:  Select all COMM Manager filters if you suspect problems between the MCA and the PC.
Select all Line filters to view the messages generated from the TAPI applications for the line.
Select all Phone filters to view all messages generat4ed from the TAPI applications for the line
addresses or DN

The Selected Categories display on the Filter Setup dialog box.
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To Add the Message Types to Each Category:

1. Right mouse click on the Category to display the options.

2. Select the Add All  option to add all entries.
Or
Click on the message type to select a single message type entry item.
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The selected message type entry items are displayed under the selected category on the Filter Setup dialog
box.

Assigning Colors to Message Type
To Select and Assign a Color to Each Message Type:

1.  Right mouse click on the message type to display the color options.



Symposium TAPI MCA Chapter 6  Troubleshooting Tips  •  82
Reference Guide

2.  Click on the color to select it.

3.  Repeat steps 1 and 2 until all message types have been assigned a color.

The Message type is displayed on the Filter Setup dialog box in the selected color.

Changing the Overflow File Defaults

Changing the Overflow file defaults consists of accessing the Options dialog box and entering a file name, a
pipe name, the maximum lines displayed in the Nortel Logger window, and the maximum size of the overflow
file.  This dialog box also allows you to select to have the Nortel Logger 32 window always on the top location
on your desktop.

While the Nortel Logger is logging messages, it writes to the overflow file when the number of lines in the
Nortel Logger 32 window reaches the given limit.  The Nortel Logger 32 window is cleared when the content of
the Nortel Logger 32 window reaches the maximum lines set on this dialog box.

To Change the Overflow File Defaults:

1.  From the Nortel Logger 32 window, click on Settings to display the Settings menu options.

2.  Click on the Options option.
The Options dialog box is displayed.
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3.  Accept the defaults provided.
Or
Enter the desired information.  Remember that if you change the pipe string name, you must set a
corresponding name for the named pipe on the TAPI server’s side manually.

4.  Click on the OK  button to save the changes and close the Options dialog box.

Using the Nortel Logger Troubleshooting Tool

The Nortel Logger Troubleshooting tool allows you to perform the following tasks:

• Save the troubleshooting information to an RTF or TEXT file.

• Append the information to an Overflow file.

• Clear the Overflow file.

• Print the troubleshooting information.

• Open a new information display window.

• Search for a particular string in the Logger display window and replace it.

Saving the Troubleshooting Information
To Save the Information in the Nortel Logger Display Window:

1.  Click on the Save button  located on the Toolbar.
Or
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Click on File located on the Menu bar to display the File menu options.

Select the Save or Save as option.

The message information is saved to the currently opened file.  If the content is from a new file or if
you selected the Save as option, you are prompted for a file name.  There are two file formats used by
the Nortel Logger: RTF and TEXT.  If the given file name has an extension as “rtf”, the file will be
saved as rich text edit format file. Otherwise the file will be saved as a plain text file.

Note:  Both Save and Save As commands only save the current content in the Nortel Logger 32
window.

The Save As dialog box is displayed.

2. Enter the file name and select the file type.

3. Click on the Save button to close the Save As dialog box.

Appending the Information to the Overflow File
Appending the current content of the Nortel Logger 32 window to the Overflow file saves the message
information in the Overflow file and clears the Nortel Logger display window.
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To Append the Information to the Overflow File:

1.  Click on File located on the Menu bar to display the File menu options.

2. Select the Append to overflow option.
The message information is saved in the Overflow file and the Nortel Logger display window is
cleared.

Clearing the Overflow File
You may be asked to clear the Overflow file before a troubleshooting session to ensure the information
messages are current.

To Clear the Overflow File:

1.  Click on File located on the Menu bar to display the File menu options.

2.  Select the Clear overflow file option.
The Overflow file is cleared of all previous information.
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Printing the Troubleshooting Information
The Print  option allows you to print the current content of the Nortel Logger window.

To Print the Information in the Nortel Logger Display Window:

Click on the Print  button  located on the Toolbar.
Or
Click on File located on the Menu bar to display the File menu options.

a. Select the Print  option.
 The Print dialog box is displayed.

b. Click on the OK  button to accept the default settings.
Or
Make changes as necessary and click on the OK  button.

The current content of the Nortel Logger 32 window is printed.

Opening a New Information Display Window
Opening a new Nortel Logger display window closes the current display window.  You are prompted to save the
current display window information before opening a new display window, if the current window is not empty.
Opening a new display window clears the current display window.

To Open a New Information Display Window:

1.  Click on the New button  located on the Toolbar.
Or
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Click on File located on the Menu bar to display the File menu options.

Select the New option.

2. If the current display window is not empty, save the current content, if desired.

The window is cleared and a new display window is opened.

Opening an Existing Troubleshooting File
To Open an Existing Troubleshooting File:

1.  Click on the Open button  located on the Toolbar.
Or
Click on File located on the Menu bar to display the File menu options.

Select the Open option.
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The Open dialog box displays previously saved Nortel Logger files.

2.  Click on the file you wish to open to highlight it.

3.  Click on the Open button.
The Open dialog box is closed and the selected file is displayed on the Nortel Logger 32 window.

Searching for a Particular String in the Logger Display Window
The Nortel Logger provides a search function to assist you in searching for a particular message string.  The
Replace option allows you to replace a found message string with a user-determined string.

To Search for a Particular String in the Logger Display Window:

1.  Click on Edit  located on the Menu bar to display the Edit  menu options.

2.  Select the Find option.
The Find dialog box is displayed.
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3.  Type the String search criteria in the Find what field.

4.  If desired, select to Match whole word only and/or Match case by clicking in the check box.

5.  Click on the Find Next button.
The results of the search are highlighted on the Nortel Logger display window.

6.  Repeat step 5 to search for addition matches.

7.  When finished searching, click on the Cancel button to close the Find dialog box and cancel the
search.

To Search for a Particular String and Replace it:

1. Click on Edit  located on the Menu bar to display the Edit  menu options.

2.  Select the Replace option.
The Replace dialog box is displayed.

3.  Type the String search criteria in the Find what field.

4.  Type the String you wish to replace the search criteria with in the Replace with field.

5.  If desired, select to Match whole word only and/or Match case by clicking in the check box.

6.  Click on the Find Next button to start the search.
The results of the search are highlighted on the Nortel Logger display window.

7.  Click on the Replace or Replace All button to replace the found string with the user-determined string.

8.  Repeat step 6 and 7 to search for addition matches and replace them.

9.  When finished searching and replacing, click on the Cancel button to close the Replace dialog box and
cancel the search.
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Exiting the Nortel Logger Troubleshooting Tool

To Exit the Nortel Logger:

1.  Click on File located on the Menu bar to display the File menu options.

2.  Select the Exit  option.  The Nortel Logger 32 window closes.
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Nortel’s TAPI Compatibility
The following figure shows TAPI Compatibility

TAPI Compatibility

Windows 3.1 and
Windows for
Workgroups 3.11
(16 bit TAPI Applications)

Windows 95
16 bit TAPI
Applications

Windows 95
32 bit TAPI
Applications

Windows NT
16 bit TAPI
Applications

Windows NT
32 bit TAPI
Applications

Microsoft TAPI 1.3
(TAPI.DLL - 16 bit)

Microsoft TAPI 1.4
(TAPI.DLL - 16 bit)

Microsoft TAPI 2.0/2.1
(TAPI32.DLL - 32 bit)

TAPI Service Provider
(16 bit - First Party )
Desktop TAPI SP 1.5/1.6

Symposium TAPI  SP for M1 R2
(32 bit - 3rd  Party via Mlink 5/AML)

Desktop TAPI SP 2.0
(32 bit - First Party)

TAPI
Thunker
(32 bit to
16 bit)

TAPI
Thunker
(16 to
32 bit)

Symposium Agent
on Windows 95
or Windows NT
(32 bit Application)

CompuCALL TAPI Driver R1
(32 bit - 3rd Party via CompuCALL
DMS/MSL-100

Active X Stuff &
32 bit OLE

OLE Automation
Controller (Ver. 1
TAPI 1.4)
“First Party only”

OLE Automation
Controller (Ver. 2
TAPI 2.0)
“3rd Party Only”

Meridian 1 Only

Figure 7  TAPI Compatibility
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Desktop TAPI SP for MCA Application Error Recovery

The following error messages could occur when you start your TAPI SP for MCA applications.

• The TAPI Line Initialize Call failed.
Error Code = 80000048

• Failed to get device capabilities.

• Line cannot be initialized.

If you get an ‘Initialization error, refer to the “Line Initialization Error” section.

If you receive any of the above messages, try the following error recovery procedures.

• Make sure your phone is working and is not deactivated.

• Be sure the light is on and flashing on the MCA.

• Check the interface device connections to the PC.

• Verify that you have selected the correct interface device, COMM ports, Switch type, and telephone
type and that the keys were assigned properly during TAPI SP Setup (see
Chapter 3).

• Restart Windows and try again.

• Uninstall and then re-install the TAPI SP for MCA 2.0 software.
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Problems

Desktop TAPI SP for MCA Fails

If TAPI SP for MCA shows a status of “Fail” after restarting TAPI, reboot your system before proceeding.  If
TAPI SP for MCA still fails, you may not have the COMM port connected, configured, or selected correctly or
the MCA device may not be working.

To Troubleshoot the TAPI SP for MCA:

1.  Access the Control Panel and double click on the Telephony icon to reinitialize the driver.
The Dialing Properties dialog box is displayed.
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2.  Select the Desktop TAPI SP for MCA (if not highlighted) and click on the Configure button.
The Desktop TAPI Service Provider for MCA dialog box displays the Status of the MCA.

3.  If the status is “Fail,” click on the Details button to display the Diagnostics information.

Information is provided on the following scenarios:

• MCA not Connected or MCA not Working

• COMM Port is Incorrect

• Configured COMM Port is Used by Another Device

 Note:  The information that is displayed in the Diagnostics dialog box depends upon your situation.  The
following screens shown are for demonstration purposes only.  The information on your screen may vary.
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 MCA not Connected or MCA not Working:

 The following information is displayed when the MCA is not connected or when the MCA is not
working:

 Follow the instructions on the screen.  Restart TAPI and check the status on the Desktop TAPI
Service Provider for MCA dialog box.
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  COMM Port is Incorrect:

 The following information is displayed when the COMM port is incorrect:

 

 After you have checked the correct COMM port and that the MCA is connected and powered, click on
the Next button. to change the configured COMM port.

 Click on the down arrow to display the list of COMM ports and select the correct one.
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 Click on the Finish button.  The following information is displayed.

 Click on the OK  button to acknowledge the information.

 Restart TAPI and check the status on the Desktop TAPI Service Provider for MCA dialog box.

 

 Configured COMM Port is Used by Another Device:

 The following information is displayed when the Configured COMM port is used by another device:

 

 Follow the instructions on the screen.  Restart TAPI and check the status on the Desktop TAPI
Service Provider for MCA dialog box.
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 TAPI Fails to Initialize

 Problem:

 After installing the TAPI SP for MCA and TAPI fails to initialize, the Microsoft TAPI system files may be
missing or may not be the latest version.  If this is the case, they need to be installed and the TAPI Service
Provider must be installed into TAPI. However, this process can vary greatly from one Windows version to
another.

  First and foremost, be sure to do version checking when installing all files.

  Second, use a setup application rather than relying on an .INF file to install Microsoft TAPI. While the ATSP
sample uses an .INF file to install, there are several major problems with using an .INF file:

• TAPI needs to already be installed.
• You can not do operating system version checking if you use an .INF file.
• You can not do file version checking with an .INF file.
• Bugs that will not be fixed in Windows NT 4.0 prevent an .INF file installation.

Third, once all the Microsoft TAPI files are installed, the TAPI SP for MCA must now be installed into TAPI.
Refer to the “Installing the TAPI SP for MCA Software” section for information on installing the TAPI SP for
MCA.

Unable to Initialize TAPI Service Provider when using Call Manager

When starting the Call Manager application, you receive the following error message:

Unable to initialize TAPI Service Provider

The Call Manager automatically tries to initialize the TAPI Service Provider on startup.  However, Call
Manager provides the capability to deselect this option for using connectivity other than the TAPI Service
Provider.  Ensure the option to initialize TAPI is selected.

To Check the Initialize TAPI default:

1.  Access the Call Manager main window.

a. Click on the Start button  located in the lower left corner of the desktop.
The Start menu displays the Windows options.

b. Select Programs/Nortel Symposium.
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c. Select Call Manager.
The Call Manager main window opens.

2. Access the Settings dialog box.

a. Click on the Setting button  located on the Toolbar.
Or
Click on Tools, located on the Menu bar of the Call Manager window.

The Tools menu is displayed.

b. Click on Settings.
The Settings dialog box is displayed.  Click on the General tab to display the General preferences,
if not already displayed.
The General options are displayed.

3. If not selected, click in the Initialize TAPI check box to select it.  A check mark means the option
is selected.
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Files Necessary for Windows 95
One complication for Windows 95 is the TELEPHON.CPL file. This file is installed to the system directory by
default along with all the rest of the Windows 95 TAPI files. However, because this file is not needed by most
people using Windows 95, it is installed in the system directory as TELEPHON.CP$ to reduce control panel
clutter. First look in the system directory for TELEPHON.CPL; if that is not found, locate TELEPHON.CP$
(also looking in the system directory), and rename it to TELEPHON.CPL.

Line Initialization Error

Problem:

If running a TAPI Application causes a "Line Initialization error" or the functions of the TAPI
Application do not seem to be working, re-check your interface device cable connections and the TAPI
Service Provider configuration.  However, you may also need to remove other TAPI Service Providers
as indicated in the workaround below.

Workaround:

Remove all other Telephony Drivers, for example, TAPI Service Providers.  Double-click on the
Control Panel’s Telephony icon, click on the unwanted Driver, and click on the Remove button.
Restart Windows.

The Installed Drivers list must include the Nortel TAPI SP entry only.

Operation Failed Error

Problem:

Receiving an OPERATION_FAILED error indicates an attempt to perform a function that the switch
does not allow.  For example, the switch does not complete a conference while one party is ringing.  It
is up to the application how handle this.  The TAPI returns the result code as OPERATION_FAILED if
the function AddToConference is called before the pending conference is answered.

Workaround:

In the example, make sure the call is answered and then add to the conference.  Generally, try the
function again.
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Problems with MCA Connectivity

Problem:

 If you have problems with the MCA connectivity device, the following Logger file contains
information when the MCA cable is not plugged in or when the MCA power supply is not plugged in or
has gone bad:

1 : vaccmain : 149:Diagnostic DLL' Loaded Tick: 109895
 1 : vacclin2 : 1628:TSPI_lineNegotiateTSPIVersion : Tick 109909
 1 : vacclin2 : 1647:OK : Tick 109911
 1 : vaccprov : 656:TSPI_providerEnumDevices : Tick 109913
 1 : vaccprov : 660:OK : Tick 109914
 2 : vaccprov : 738:InitTimeoutSeconds is 60000 ms
 1 : vaccprov : 747:TSPI_providerInit : Tick 109938
 1 : vaccprov : 749:InitTimeOut: 60000
 1 : vaccprov : 750:Free space 0x1bc9000
 0 : vaccwin : 350:7334
 1 : vaccprov : 835:Applet window handle 0x1cc
 1 : vaccprov : 838:Applet task handle 0x258e
 2 : vaccwin : 254:WM_VACC_START Tick 109995
 2 : drvstart : 133:Inspect timer ticks: 5 0x5
 0 : accutils : 566:MCA not connected or powered
 2 : accints : 1355:Bad status from OpenCommPort 64
 0 : accmain : 256:InitDriver failed
 0 : accmain : 340:AccInstall failed
 0 : ntapi  : 104:InitialiseDriver failed
 1 : vaccwin : 103:mWinRegister: 9
 0 : vaccprov : 224:WM_VACC_START result: 0x3e6 Aborting Provider initialization
 1 : vaccprov : 869:OPERATIONFAILED : Tick 110775
 0 : vaccmain : 558:At the very end of the wep for vaccess Tick: 110778

Workaround:

Check that the MCA cable is plugged in and the power supply is turned on and connected to the MCA.
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TAPI Applications Do Not Display Correct Information

Problem:

Symposium TAPI MCA 2.0 interprets only information presented to the bottom line of the phone set’s
display.  DNIS, which appears on the top line, is not captured or interpreted.  Calling ID and Called ID
information delivered to the TAPI application follows these supported formats.  Refer to the
“Supported Display Formats” section located in Appendix C for the supported formats.

Problem:

If your TAPI Application does not display the correct calling number or calling party's name, the name
assigned to the line in the switch may need to be changed. The TAPI Service Provider may not deliver
the correct Calling number or name to the TAPI Application if the name is configured as indicated
below or the first letters in the name conflict with the Reason Codes defined under PBX/Switch
Parameters:
Name Format: Name + a space + a number
Example:  John Smith 2

Workaround:

From a M1 PBX Administration Terminal use LD 95 to change the name so that a space and number
do not follow the name.

Also, verify that the Reason Codes defined under PBX/Switch Parameters match the parameters
defined in LD 95 on the Meridian 1 PBX and do not conflict with the Name displayed for the calling
party.

Problem:

In high traffic environments, when multiple calls are arriving at the same set at the same time you are
trying to dial out, some digits of the dial out string get lost.  For example, if you are dialing 932-1450,
your set may display 21450.

Workaround:

Add the following variables to the nttapisp.ini file under [Telephone]:
MaxCalls= defaults to 10, must be between 8 and 64
TxQueueSize= defaults to 100, raising may eliminate signals being dropped
RxQueueSize= defaults to 500, raising may eliminate signals being dropped
MaxEvents= defaults to 80, must be between 64 and 128

Problem:

In high traffic environments, when more calls are coming in faster than the system can handle, such as
when calls are coming in faster than one call every two seconds, the driver may report incorrect name
and number information to the TAPI application.

Workaround:

This is a limitation of the TAPI SP for MCA.

Problem:

Parked calls that return to the phone set may report incorrect calling name and number.  This occurs
when the calls are parked on a switch other than the switch where the call originates.

Workaround:

After unparking the call, hold and unhold the call and the display reports the correct information.
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Desktop TAPI SP for MCA Files

After completing the installation of the TAPI SP for MCA software, files are copied to the directories listed in
the following table:

Table 8  TAPI MCA 2.0 files

Filename Install Type Destination Comments
License.txt N/A N/A This file is not copied

Readme.txt N/A N/A This file is not copies

Logdll.dll Typical System directory See *Note below

NortelLogger.exe Typical c:\Program files\Nortel
Networks\Desktop TAPI SP for MCA

Installation directory chosen by user

Phone.exe Typical c:\Program files\Nortel
Networks\Desktop TAPI SP for MCA

Usrguide.pdf Typical c:\Program files\Nortel
Networks\Desktop TAPI SP for MCA

MCATSP.tsp Typical/Compact System directory See *Note below

Uninstall.isu Typical/Compact c:\Program files\Nortel
Networks\Desktop TAPI SP for MCA

This is created during the installation
process to allow an uninstallion from
the Add/Remove Programs applet in
the Control Panel

*  Note
     On Windows 95/98 systems, the System directory is usually c:\Windows\System
     On Windows NT systems, the System directory is usually c:\Winnt\system 32

Removing Microsoft TAPI 2.1 Software

If you are using Windows 95 or Windows NT with Microsoft TAPI 2.1 and want to install and use the TAPI SP
for MCA, you must uninstall the TAPI 2.1 software and reinstall your system’s original TAPI system files.  This
will install Microsoft TAPI 1.4.

To Uninstall TAPI 2.1 Software on Windows 95 system:

1.  Locate the file REMTAPI.INF for Windows 95, or REMTAPIN.INF for Windows NT.

2.  Right-click on the file, then click on “Install.”
This will reinstall your original TAPI system files.

3. Place the TAPI.dll for Microsoft TAPI 1.4 in your Windows\System directory.

Note:  When you take Microsoft TAPI from 2.1 to 1.4, you must have a copy of the TAPI.dll for the 2.1 version.
This DLL can be obtained from a Windows 95 CD or from a machine that is already using the TAPI SP for
MCA.

To Uninstall TAPI 2.1 Software on Windows NT system:

If you wish to uninstall TAPI 2.1 and return to Microsoft’s TAPI 2.0 on Window NT only, follow the following
steps:

1.  Locate the remtapin.inf file.

2.  Right click on the correct file and select the Install  option.

Note:  If you use the remtapi files, you may have to copy the Telephony.cpl file back into the Windows\system
directory.
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Removing the TAPI SP for MCA Software

If it becomes necessary to remove TAPI SP for MCA software, remove it from the Telephony Drivers and then
use the Windows Add/Remove feature located on the Control Panel to remove the files.

To Remove the TAPI SP for MCA Software:

1.  Select Start/Settings/Control Panel.
The Control Panel window is opened.

2.  Double-click on the Telephony icon.
The Dialing Properties dialog box is displayed.

3.  Click on Desktop TAPI SP for MCA to highlight it.

4.  Click on the Remove button.
You are asked to verify the remove command.

5.  Click on the Yes button.
The Desktop TAPI SP for MCA is removed and the Dialing Properties dialog box is displayed.

6.  Click on the OK  button to close the Dialing Properties dialog box.
The Control Panel window is opened.

7.   Double-click on Add/Remove Programs.
The Add/Remove Programs dialog box is displayed.

8.  Select the Desktop TAPI SP for MCA option from the list and click on the Remove button.
The TAPI SP for MCA files are removed.
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Appendix A  Additional User Information

Appendix A provides additional user information.  This information includes how to receive technical support, a
summary of the online documents, and information on using the Adobe Acrobat Reader to view the online
documentation.

Technical Support for the MCA TAPI Product

If you have difficulty when using the MCA TAPI product, help is available in different formats.  This document
provides troubleshooting tips in Chapter 6.  For telephone support in the United States and Canada, contact your
Nortel support personnel.

Technical Assistance (800) 527-0797
Product Information (800) 4-Nortel
Developer Support (800) NT4CTI0

Outside the United States and Canada, contact your Nortel Support or Sales representative.

To resolve a TAPI SP for MCA problem properly, Nortel field support personnel may require the following
information:

1. A description of the problem, sufficiently detailed to help Nortel reproduce the problem.  For example,
if the problem involves screen pops, the description should include not only what appears on the PC
monitor (TAPI application), but also what appears on the phone's display, with as much accuracy as
possible—including numbers, dashes, and names that appear on the top and bottom lines of the display.

2. A printout of the nttapisp.ini file, VISIT.ini, telephon.ini, and the autoexec.bat.

3. Printouts of certain switch datafill.  On Meridian 1, use LD 20 to print the TNB of the set.  Ask your
switch administrator for these.

4. The switch software release number.  For the Meridian 1, indicate the X11 Rel. 19, 20, and so forth.

5. A log file of the problem (by running the Logger troubleshooting tool to create and save a log file ).
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Overview of the Online Documentation

The User documents for the TAPI SP for MCA are provided electronically as online documents.  However, your
version of the TAPI SP for MCA may or may not contain all of the available documents.  The following chart
provides the name of the document, the file name and a description:

Document Name File Name Description

Nortel Symposium TAPI MCA
Reference Guide

Usrguide.pdf This reference guide provides information on installing,
configuring, and using the MCA and the Desktop TAPI SP
for MCA.

Nortel Symposium Desktop TAPI
Service Provider Programmer’s Guide

Progvol1.pdf This document contains information that is helpful to
developers who are writing applications that may use the
Desktop TAPI SP for MCA.

The Adobe Acrobat Reader must be installed to access the online documentation.  After installing the Adobe
Acrobat Reader, double-clicking on the .PDF file opens the online document in the Acrobat Reader window.

Overview of the Adobe Acrobat Reader

The Acrobat Reader Window

The Acrobat Reader window contains menus, tools, and buttons.  The Menu bar of the Acrobat Reader window
displays the Help menu.  The Help menu contains important information on how to view and print the
document.  The Toolbar on the Acrobat Reader window provides tools for working with the documents.  Select
a tool by clicking the icon.

The online documents contain bookmarks to assist you in finding information.  Selecting the Bookmark button

 provides an automated table of contents.

The Bookmarks are displayed on the left of the window.

Clicking on the Expand icon  located to the left of the bookmark displays additional topics in a tree-view.
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Clicking on the Collapse icon  removes the additional topics.
Clicking on a Bookmark takes you directly to the page containing the information.

Using Links on the Adobe Acrobat Window

The Table of Contents, Index, and certain words or phrases provide direct links to the page associated with the
entries.  Links are red boxes that enclose a page number or word.  Clicking on the red box displays the page that
contains the information.

In addition, certain pages reference additional information.  When these references are enclosed in a red box,
clicking in the box displays the referenced page or document.

Clicking on the Back button  displays the previous page.
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Appendix B  Additional MCA Information

Appendix B provides additional MCA Information that may be helpful when installing and using the MCA.

Telephones without MCA Compatible Foot stands

Meridian Digital Telephones manufactured before February 6, 1998 must have the foot stand replaced with an
MCA compatible foot stand.  See the label in Figure 8 for easy identification.  These sets also required the
installation of a jumper inside the telephone.

Figure 8  Telephone set label with invalid Warranty Start Date

This figure shows the Warranty Start Date before the 05/06/98 date, which requires the MCA compatible
footstand and internal jumper.

Internal Jumper Requirements

The internal jumper is installed on Meridian Digital Telephones manufactured after February 6, 1998, and
identified with a Warranty Start Date code of 05/06/98 or later.  Telephones with a Warranty Start Date code
05/05/98 or earlier require an ATA/MCA Jumper Kit (NT2K71AA, orderable as merchandise.  Two jumpers
are included in the ATA/MCA Jumper Kit.  The Jumper with the Black connector referenced below is designed
for use with NT2Kxxxx or NT9Kxxxx telephone vintages.  The Jumper with Brown connector is designed for
use with NTZKxxxx vintage telephones.
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Figure 9  ATA/MCA Jumper Kit

The following diagrams highlight the placement of the Jumper when used on NT2K / NT9K vintage telephones
as opposed to the earlier model NTZK telephones.

Figure 10  Jumper Placement

Preparing the Telephones without MCA Compatible Foot stands

To Prepare the Telephone without the MCA Compatible Foot stand:

1. If you have the NTZK or NT2K telephone (date code prior to April 1998),remove and discard the foot
stand.

Note: To remove the foot stand from the telephone base, press in the back edge of the foot stand as you
lift it from the telephone base.
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2. If you have an MPDA installed, unplug it from the data line jack in the telephone base.

3. Remove the foot stand and then remove the back covering of the telephone base (four screws).

4. If the telephone is equipped with a Power Supply board and/or cable, (refer to illustration below) you
must remove them before installing the MCA.

a. Remove the two screws from the Power Supply board and set them aside.

b To remove the Power Supply board from the NTZK telephone, grasp the board on each side and
rock it while applying upward pressure, until it is released.

c To disconnect the Power Supply board from the NT2K telephone, lift the board out of the set and
disconnect the ribbon cable from the 2X7 pin connector.

5. If the telephone is equipped with the External Alerter board, you must remove it before installing the
MCA. The External Alerter board is located inside the telephone base right of center. Refer to
illustration below.

· Remove the screws from the Extemal Alerter Interface board.
· Grasp the board firmly on each end and pull upward to remove it from the 2X3 pin connector.

6. Remove the knockout sections in the rear wall of the foot stand for the MCA DB-25 connector and the
Power Transformer DIN connector. To remove the knockout sections, use a flat tip screwdriver to push
out the plastic pins holding the knockout in place.

Refer to the “Installing the MCA” section located in Chapter 2 for information on installing the MCA once the
telephone is prepared.
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Additional MCA Configuration and User Information

Default MCA Configuration

The MCA is configured in asynchronous mode when it is shipped from the factory.

These parameters can be changed using keypad dialing commands, or in LD 11 with Xll release 18 and later. To
change a parameter listed here, refer to the keypad dialing section of this guide.

MCA defaults to synchronous or asynchronous mode from the telephone.  Listed here are the default parameters.
The mode is determined prior to resetting the parameters.  Refer to the Reset data parameters section in this
guide for more information.

Asynchronous Synchronous

Keyboard dialing Hot Line Off

Autoanswer Autoanser

DTR OFF DTR OFF

DCD ON DCD ON

Baud rate 9600 Baud rate 56000

Hot Line OFF Virtual Leased Line OFF

Remote Loopback OFF Remote Loopback Off

Full duplex Full duplex

Assert RTS ON PSDS OFF

Space parity Internal clock

Terminal mode Modem Mode

SL-1 Mode

V.25 bis OFF

Additional Asynchronous Features

Autobaud
Autobaud is enabled each time you release a data call.

Each time you enter <CR> to activate keyboard dialing or the letters "AT" to activate AT dialing, the MCA
times the length of bits received and sets the baud rate accordingly.

Autoparity
The MCA automatically sets the parity each time the letters "AT" are entered for AT dialing.

In Keyboard dialing you must enter a period (.) and <CR>. This is normally the first step to take when your
terminal displays a garbled prompt.
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Modem Pooling
When you dial a modem pool, the MCA prompts:

ENTER REMOTE NUMBER

Enter number of external modem to access and <CR>.

CALL CONNECTED.SESSION STARTS

Making a Data Call

Before using the MCA to make data calls:

Make sure your MCA is present within your Meridian Modular Telephone. In the back of the telephone, a red
LED will be blinking at the constant rate to indicate the MCA is powered up and ready to go.

Attach your terminal or PC serial port to the MCA 25 pin D connector via an RS-232 or V.35 cable.

Make sure that your terminal or PC is powered up and ready to send data.

If you are using a PC, your communication software (to make your PC emulate a terminal) should be running.

The procedures in this section are all you need to make basic data calls. To find out more about the MCA's
features and capabilities, see the following sections, which describe the three dialing methods in more detail.

The three methods are provided for your convenience. Use the dialing method you find most comfortable, or
which performs the functions you desire to use.

Note: Throughout this guide, <CR> refers to a carriage return.

Keyboard dialing

1. <CR>.

ENTER NUMBER OR H (FOR HELP):

22 Enter number of far end data device and <CR>.

CALL C0NNECTED.SESS10N STARTS 3 <CR>.

Follow normal procedures for logging on and using the data service.

AT dialing

1. AT <CR>.

OK

2. ATDxxxx (where xxxx is the number of the far end data device).



Symposium TAPI MCA Appendix B  Additional MCA Information  •  114
Reference Guide

CONNECT

3. <CR>.

Follow the normal procedures for logging on and using the data service.

Keypad dialing

1. Press PROGRAM and dial # on phone's keypad. If your phone has a display it will show:

MDIAL

ENTER DIGITS. P TO EXIT

2. Dial number of the far end data device. Display will prompt (if call is successful):

DATA CALL CONNECTED Terminal will prompt:

CALL CONNECTED.SESSION STARTS 3 <CR>.

Follow normal procedures for logging on and using the data service.

Releasing a data call

To release a call while in asynchronous mode, use any of the following methods:

-- Hold down break key(s) for 1.6 seconds or longer. Note that this method is not supported on terminals
with non-overlapping timed break.

-- Press break key(s) three (3) times in quick succession. The break must be at least 1 O0 milliseconds and
all 3 breaks must be within 1 second.

-- Press PROGRAM on phone and dial

-- Drop DTR.

-If the far end data device releases the call, the MCA automatically drops its end.

Release a synchronous call using one of these methods:

-- Drop DTR

-- Press PROGRAM on your telephone and dial [].

When a data call is disconnected, the terminal displays the following :

RELEASED
Or
NO CARRIER (in AT dialing mode)

Dialing Methods

The MCA provides three methods for making data calls through Nortel Networks's PBX: keyboard dialing, AT
dialing, and keypad dialing. Keyboard and AT dialing are done by entering commands at a terminal (or a PC
running software to make it emulate a terminal), while Keypad Dialing is done via the telephone keypad.

Keyboard dialing is menu driven. Data calls are made by hitting <CR> to get a Main menu. By navigating
through the menus, different features can be activated.

AT dialing is very similar to methods used to make modem calls with a Hayes Smartmodem*. The user enters a
command starting with the letters "AT" followed by a few letters to distinguish the command, and a <CR>.
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Keypad dialing uses the top right-hand function key on the telephone set, labeled PROGRAM ( this key is also
referred to as the P-key). All keypad dialing is done by first pressing PROGRAM followed by a two digit
command to be executed. You must hit Program again to execute the command, and to relinquish the keypad
for use by the telephone set or to enter additional commands.

*Smartmodem is a trademark of Hayes Microcomputer Products Inc.

Switching between keyboard and AT dialing

To switch between AT dialing and keyboard dialing, you must be in the idle state (not connected to a far end
data device). That is, the most recent prompt must be either:

NO CARRIER
or
RELEASED

At this point you may type AT to get AT dialing or <CR> to activate keyboard dialing.

Keyboard Dialing

This section explains the keyboard dialing commands and how to use them. You can enhance your data call
dialing by using features such as Speed Call and file scripting.

Keyboard dialing is menu-driven. Examples are on the previous page. Use them as a reference when following
procedures.

Each procedure in this chapter assumes you are beginning at the initial prompt of:

ENTER NUMBER OR H (FOR HELP):

To get the initial prompt, hold down the break key(s) for at least 1.6 seconds and hit the carriage return (<CR>).
This will release a current data call if you are on one.

Abort current command

To abort the current command:

1. Hold down the control key and press Z.

RELEASED

2. <CR>.

ENTER NUMBER OR H (FOR HELP):

Note: This command will not work during an active data call. First you must release the call.

Auto Dial

To use:

1. A (Auto Dial) <CR>.

CALLING
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To define (change):

1. M (Modify) <CR>.

(Terminal displays Modify menu)

2. A (Auto Number) <CR>.

AUTO DIAL NO.:

3.  Enter Auto Dial number and <CR>.

Speed Call

To use:

1. S (Speed Call) <CR>.

ENTER ACCESS CODE:

2. Enter the access code (Speed call code) and <CR>.

CALLING

To define (change):

1.  M (Modify) <CR>.

(Terminal displays Modify menu)

2.  S (Speed Number) <CR>.

ENTER ACCESS CODE:

3. Enter access code (Speed Call code) of the number you wish to define or change. It can be one, two, or
three digits.

ENTER NUMBER: xxx-

(xxx = access code)

4. Enter extension number (DN) to be represented by the access code, and <CR>.

Script File

To use:

Enter script name and <CR>.

The MCA will connect to the far end data device and the script will be executed automatically. In other
words, the MCA will follow the same steps you took when writing the script. It works like a macro file.

To define:

1. M (Modify) <CR>.

(Terminal displays Modify menu)

2. F (Script File) <CR>.

(Terminal displays Script File menu)
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3. L (Learn Script) <CR>.

(Terminal displays Learn Script menu)

4. A (Learn Auto Dial script) <CR>.
Or
S (Learn Speed Call script) <CR>. Enter Speed Call code at prompt ENTER ACCESS CODE: and
<CR>.

ACTIVATE LEARN MODE? (Y/N)

5.  Y <CR>.

ENTER SCRIPT NAME:

6. Enter name you want to call the script by and <CR>.

ESCAPE CODE =[+] MODIFY (Y/N)

(+ = escape code key symbol)

7.  N <CR>.

(Terminal displays Main menu)

8. Make a data call, following the exact procedure you wish the script to remember. Press Escape twice
(to enter privacy mode for password protection. Press <CR> to exit privacy mode.

9. When you wish to end the script, press Escape three times in quick succession. Continue normally.

10.  Release the data call and immediately place an Auto Dial or Speed Call for which the Learn Script
process was set up. At this point the script is saved.

Script File directory

To view a list of your script files:

D (Script File directory) <CR>.

Your terminal lists the script file names and length in bytes, plus each script's associated speed call
access code (an A in the access code column stands for the Auto Dial script).

See example on this page.

SCRIPT FILE DIRECTORY

ACCESS CODE SCRIPT NAME LENGTH(Bytes)

A EMAIL 262

21 MAINFRAME 455

33 DBASE 345

Delete Script File

1.  M (Modify) <CR>.

(Terminal displays Modify menu)

2.  F (Script File) <CR>.

(Terminal displays Script File menu)

3. D (Delete Script File) <CR>. (Terminal displays Delete menu)
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4. A (Auto Dial) <CR>.
Or
S (Speed Call) <CR>. Enter speed Call code at prompt:

ENTER ACCESS CODE:

SCRIPT [script name] EXISTS

DELETE? (Y/N)

5. Y <CR>. DELETING.

Escape code

To change Escape code:

1.  M (Modify) <CR>.

(Terminal displays Modify menu)

2.  F (Script File) <CR>.

(Terminal displays Script File menu)

3. E (Escape Code) <CR>.

ESCAPE CODE :[+] MODIFY (Y/N)

4. Y <CR>.

ENTER ESCAPE CODE:

5. Enter new Escape code (can be a control character) <CR>.

There are three uses for the Escape code character:

--One escape character inserts a pause in a script file.

--Two escape characters puts you into privacy mode, useful for skipping part of a script file procedure for
password protection. Hit <CR> to leave privacy mode.

--Three escape characters saves a script file to the MCA EEPROM.

Note: A guard timer of one second distinguishes the escape sequences. In other words, one escape character is
not interpreted as a pause until a full second elapses in which you do not enter another escape character.

Manual answer (asynchronous)

1. M (Modify) <CR>.

(Terminal displays Modify menu)

2. M (Manual Answer) <CR>. MANUAL ANSWER (Y/N).

3. Y <CR>.

Incoming data calls will give you this prompt:

INCOMING CALL. ANSWER (Y/N)

If you respond Y to the prompt in step 2, an incoming data call will connect automatically and you will
receive the prompt:

INCOMING CALL CONNECTED
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Remote Loopback

To perform a remote Iccpback test:

M (Modify) <CR>.

(Terminal displays Modify menu)

R (Remote Loopback) <CR>.

Remote Ioopback will be enabled for the next data call only.

This feature is useful for diagnostic purposes.

Ring Again

When the far end number is busy you receive the prompt:

BUSY, RING AGAIN? (Y/N)

or

BUSY, PREVIOUS RING AGAIN ACTIVE, REPLACE? (Y/N)

1. Y <CR>. Ring Again is activated and will notify you when the far end is free.

RING AGAIN PLACED

When the far end data device is free you receive the prompt:

DATA STATION NOW AVAILABLE, PLACE CALL (Y/N)

2.  Y <CR>.

Note: You must answer Ring Again with 30 seconds after you are prompted or it cancels. You can only set Ring
Again to watch one busy line at a time.

Ring Again (synchronous)

Synchronous calls can only be made from the telephone keypad.

Display parameters (asynchronous)

To list information about MCA configuration from the terminal:

P (display parameters) <CR>.

The following example shows the items listed with possible values for each.

The first three parameters give information on the current version MCA you have (they do not change).

For more detailed descriptions of these parameters, see Keypad dialing.
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Engineering code = NT2KO047 Release = 01

Firmware = 3.5

Baud Rate = 19200

Parity = ODD

DTR = ON (Data Terminal Ready) DCD -- ON (Data Carrier Detect) VLL = OFF (Virtual Leased Line)
Hotline = OFF

Remote Loopback = OFF Manual Answer = OFF

Data Directory Number = 4000 Auto Dial No. = 3600

Keypad Dialing Commands

Keypad dialing refers to the commands you can invoke from your phone's keypad. The top right-hand function
key on your phone is called the Program key, or P-key. In the commands listed below, the number is the
command number (or symbol) dialed on the keypad after dialing

To use Keypad dialing:

1. Press Program.

2. Dial the command number.
Follow the screen prompts for additional command parameters (if needed).

3 Press Program to execute.
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# - Manual Data Call

+ - Release Data Call

0  5 - Language Selection

2  0 - Asynchronous Mode

2  1 - Synchronous Mode

2  2 - Baud Rate

2  3 -  Space Parity

2  4 - Odd Parity

2  5 - Even Parity

2  6 - Mark Parity

2  7- Host Mode

2  8 -Terminal Mode

2  9 - Hotline Off

3  0 - Hotline On

3  1 -Virtual Leased Line Off

3  1 -Virtual Leased Line On

3  2 - Forced DTR Off

3  4 - Forced DTR On

3  5 - Dynamic Carrier Detect Off

3  6 - Dynamic Carrier Detect On

3  7 - Remote Loopback Off

3  8 - Remote Loopback On

3  9 -Cancel Data Ring Again

4  0 - Full Duplex

4  1 - Half Duplex

4  2 - Modem Mode

4  3 - Network Mode

4 4 - Internal Clock

4  5 - External Clock

4 6 - PSDS Mode Off

4  7 - PSDS Mode On

4  8 - Enable Echo Canceller

4  9 - Disable Echo Canceller

5  0 - SL-1 Mode

5  1 - SL-1/DMS-100 Mode

5  4 - V.25 bis mode Off

5  5 - V.25 bis mode On

5  6 - Bisync On

5  7 - HDLC On

5  8 - Assert RTS Off

5  9 - Assert RTS On

6  0 - Auto Dial Programming

6  1 - Auto Dial Call

6  2 - Data Parameter Display

6  3 - EIA leads Status Display

6  4 - Monitor data call

6  5 - Reset to Default Parameters

6  6 - Emulation selection

6  7 - Lock/unlock data parameters

6  8 -VDN Key Assignment

Note 1: If you do not have a Display on your phone, the following commands do not apply:  Program 6 2,

Program  6  3, Program 6 4.

Note 2: Use Program 5  5  and Program 5  7  (HDLC On) for Group IV FAX.   Use Program  5  5 and
Program 5  6  (Bisync On) for video.

Note 3: A display is needed to use synchronous mode.

Note 4:  When V.25 Program 5  5  is turned on, the MCA automatically switches to synchronous mode.  No
auto-answer is provided while in the V.25 mode.

Note 5: If an MCA in synchronous mode calls another data module in asynchronous mode, the call is
connected. You must drop the call.
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Parity and Character Length on the MCA

In Asynchronous mode the MCA is designed to work with 8 bit data characters. You can use various parity
settings, but the total character length must equal 8 bits. The MCA accepts the following character lengths and
parity settings:

8 data bits, no parity bit

7 data bits + one bit of Even parity 7 data bits + one bit of Odd parity 7 data bits + one bit of Mark parity 7
data bits + one bit of Space parity

For ASCII data, 8 bits no parity equals 7 bits with space parity.

The MCA controls parity only when it displays prompts before the data call is established. In this case, the MCA
outputs the prompts to the DTE with the parity settings defined with P23-P26, or it determines parity
automatically with the <CR>. <CR> sequence.

Once the data call is established, the MCA does not check or regenerate parity, The MCA will transport the 8 bit
character to the far end with the parity unchanged.

Voice call origination

By using a special cable, the MCA can communicate with two DTEs at the same time. The primary channel is
the main communication channel offering MCA features. The second channel can respond to Voice Call
Origination commands (VCO) only. This provides the ability to make a voice call across the second channel
while simultaneously using the primary channel to transmit or receive high speed data.

Below is the pinout list to connect the second channel.

Note: The VCO baud rate is 2400.

RS-232 pin V.35 pin

TxD 14 18

RxD 16 21

Gnd 7 7

Configuring the MCA with a V.35 Interface:

To use the MCA with a V.35 interface, an adapter cable is required to convert the D-25 into the 34 pin
connector.

Note: This does not apply to asynchronous mode.

The female cable ordering number is A0408927, and the male cable is number A0408928.

Remove the two 12 pin jumpers inside the MCA, and install the V.35 sockets.
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Note: The MCA is shipped with jumpers configured for RS-232. Data transmissions higher than 19.2 Kbps
should use V.35 mode.  If the jumpers are left in V.35 mode, and you try to use asynchronous
transmission, the MCA will look as if it is locked up.

Configuring for V.35 Applications

The MCA is shipped with jumpers configured for RS-232. To configure V.35 in the field you must install
jumper plugs in V.35 mode as follows (please refer to the MCU/MCA reference guide (P0743724), or NTP553-
2731-109 for jumper locations):

New units, assumes new unit, not previously installed.

1 Connect MCA to telephone jack.

2 Press Program and dial 2 / 1 to select SYNCHRONOUS mode.

3 Press Program and dial 2 / 2 to select Synchronous BAUD RATE.

4 Move jumpers from RS-232 sockets to V.35 sockets.

5. Run V.35 application to confirm proper operation.

Existing units, if the MCA has been previously installed in any application.

1. Ensure that the MCA has jumper plugs in the RS-232 sockets and not in the V.35 sockets.

2 Follow steps 1 through 5 in the previous section on configuring new units.
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Appendix C  Supported Features

Appendix C identifies the differences in Desktop TAPI SP 1.6 and Destkop TAPI SP for MCA 2.0.  In addition,
this appendix lists the features, line functions, and display formats that the TAPI SP for MCA supports.

Differences - Desktop TAPI 1.6 Vs TAPI MCA 2.0

• LINECALLINFO

-- Generally, CallerID information is sent up to an application using LINECALLINFO messages
as soon as the information is available.

-- Typically, an application will see multiple LINECALLINFO messages throughout the progress
of an incoming or outgoing call.

• Transfers

-- All transfer operations will utilize the Transfer key only, if present.  It will not simulate
Transfer using a Conference Key.

-- lineCompleteTransfer() now supports dwTransferMode=CONFERENCE.

-- The Service Provider cannot track a Transfer that is manually completed to a Conference. The
Service Provider will treat this as an aborted Transfer and will simply IDLE the consult call
handle.

-- No consult call handle is presented to an application when lineBlindTransfe()r is invoked.

-- If lineBlindTransfer() fails for any reason, the consult call will immediately be dropped by the
Service Provider.

• Conferences

-- Conferences, which are started manually by the user, are tracked by the Service Provider and
can be completed using lineAddToConference().

• Call Progress of consult calls

-- Consult calls cannot be tracked accurately for far-end connect.

-- After reasonable timeouts, call progress events are simulated through LINECALLSTATE
messages.  These will be detailed in the Programmer’s Guide.

-- Telephone Set Add-on Modules are not supported

-- The TAPI SP will not recognize DNs on an add-on module.
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Desktop TAPI SP for MCA Feature Support

TAPI applications can do screen pops (database queries of a Calling or Called number) by using information
delivered by the TAPI SP for MCA.  The TAPI SP for MCA receives the information from the M1 Option 11-
81 PBX via the following configuration.

1. Receipt of IANI digits (Calling numbers) only from Telco over IANI enabled DID or Tie trunks that
auto-terminate at an ACD DN (Agents set).

2. Receipt of CLID digits (CLID-Calling number) only from Telco or private network over ISDN PRI
trunks that have CLID enabled.

3. Receipt of DNIS digits (Called number) only from Telco over DID or Tie trunks that auto-terminate at
an ACD DN Agents set or are routed via the Incoming Digit Conversion (IDC) feature to specified
ACD DNs base on the dialed number.

4. The combination of configurations 2 and 3 above allows screen popping on Calling number (via ISDN
PRI/CLID) and Called number (via DNIS) simultaneously.

The TAPI SP for MCA delivers Calling Party Name Display and Network Calling Party Name Display
information if provided over ISDN PRI trunks to TAPI applications.

Note:  When an ACD agent transfers a call that has already received the Calling/Called number, the party that is
receiving the transferred call will also receive the Calling/Called number (because M1 passes along the CLID
and DNIS digits); giving the appearance of an Agent-to-Agent screen transfer.  TAPI applications that do screen
popping find this useful.

The TAPI SP for MCA currently supports the features listed in the “Features Supported on the Meridian 1/SL-
1” section.
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Features Supported on the Meridian 1/SL-1

Features Nortel’s
TAPI SP 1.0

Nortel’s Desktop
TAPI SP 1.6

TAPI SP for
MCA version
2.0

Make Call Yes Yes Yes

Answer Call Yes Yes Yes

Hold and Un-hold call Yes Yes Yes

Blind Transfer Yes Yes Yes

Supervised Transfer Yes Yes Yes

Conference Call (3 party & 6 party) Yes Yes Yes

Consult Call Yes Yes Yes

Ring Again (Activate & Cancel) Yes Yes No

Call Pickup Yes Yes No

Call Park (Park & Retrieve Park) Yes Yes No

Call Forcing * Yes Yes No

• Meridian 1 PBX only
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Supported Line Functions

• lineAccept • lineAddToConference

• lineAnswer • lineBlindTransfer

• lineClose •  lineCloseCall

• lineCompleteTransfer • lineConfigDialog

• lineDial • lineDrop

• lineGenerateDigits • lineGetAddressCaps

• lineGetAddressID • lineGetAddressStatus

• lineGetCallAddressID • lineGetCallInfo

• lineGetCallStatus • lineGetDevCaps

• lineGetDevConfig • lineGetExtensionID

• lineGetID • lineGetLineDevStatus

• lineGetNumAddressIDs • lineHold

• lineMakeCall • lineNegotiateTSPIVersion

• lineOpen • linePrepareAddToConference

• lineSetDefaultMediaDetection • lineSetDevConfig

• lineSetStatusMessages • lineSetupConference

• lineSetupTransfer • lineSwapHold

• lineUnhold • lineSetCurrentLocation

• lineConfigDialogEdit
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Supported Display Formats

Symposium TAPI MCA 2.0 interprets only information presented to the bottom line of the phone set’s display.
DNIS, which appears on the top line, is not captured or interpreted.  Calling ID and Called ID information
delivered to the TAPI application follows these supported display formats.

• General format numbers can have the following formats:

-- xxxx // All digits

-- Hxxxx // H immediately followed by digits only until WS

-- Hxxx-xxxx // H immediately followed by digits separated by a single dash until WS

• General format numbers for both incoming an outgoing calls

-- Format1: xxxx

-- Format2: xxxx yyyy

-- Format3: xxxx reason

-- Format4: xxxx yyyy reason

• Incoming call formats

-- All numbers must contain only valid digits

-- Format11: xxxx-xxxx // Trunk

-- Format12: xxxx-xx-yyyy // Trunk + DNIS, yyyy=DNIS

-- Format13: xxxx-xx-yyyy zzzz // Format12 + ACDQ, zzzz=ACDQ

-- Format14: xxxx-xx-yyyy zzzz reason // Format13 + reason

-- Format15: xxxx-xxxx yyyy // Trunk + ACDQ

-- Format16: xxxx -yyyy // Caller + DNIS, yyyy=DNIS

• Outgoing call formats

-- All numbers must contain only valid digits

-- Format21: xxxx-yyyy // xxxx = ACDQ, yyyy = Agent Position

-- Format22: zzzz xxxx-yyyy // zzzz = Dialed DN + Format21

-- Format23: xxxx-yyyy reason // Format21 + reason

-- Format24: zzzz xxxx-yyyy reason // Format22 + reason
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Appendix D  License Agreement

THIS LEGAL DOCUMENT IS A LICENSE AGREEMENT ("LICENSE") BETWEEN YOU, THE END-
USER DEVELOPER ("CUSTOMER") AND NORTHERN TELECOM INC. ("NORTEL NETWORKS").  BY
DOWNLOADING AND INSTALLING THIS SOFTWARE PACKAGE, OR BY EXECUTING A
CONTRACT FOR PURCHASE OF A SYSTEM WHICH INCORPORATES THIS USER SOFTWARE
AGREEMENT, YOU, THE CUSTOMER, AGREE TO BE BOUND BY THE TERMS OF THIS LICENSE.

Subject to the terms hereinafter set forth, Nortel Networks grants to CUSTOMER and/or representatives, with a
"need to know," a personal, non-exclusive license (1) to use certain Licensed Software, proprietary to Nortel
Networks or its suppliers, contained as an integral part of the Hardware; and (2) to install and use each item of
Licensed Software not an integral part of the Hardware; and (3) to use the associated documentation.

CUSTOMER is granted no title or ownership rights, in or to the Licensed Software, in whole or in part, and
CUSTOMER acknowledges that title to and all copyrights, patents, trade secrets and/or any other intellectual
property rights to and in all such Licensed Software and associated documentation are and shall remain the
property of Nortel Networks and/or Nortel Network's suppliers.  The right to use Licensed Software may be
restricted by a measure of usage of applications based upon number of lines, number of ports, number of
terminal numbers assigned, number of users, or some similar measure.  Expansion beyond the specified usage
level may require payment of an incremental charge or another license fee.

Nortel Networks considers the Licensed Software to contain "trade secrets" of Nortel Networks and/or its
suppliers.  Such "trade Secrets" include, without limitation thereto, the specific design, structure and logic of
individual Licensed Software programs, their interactions with other portions of Licensed Software, both
internal and external, and the programming techniques employed therein.  In order to maintain the "trade secret"
status of the information contained within the Licensed Software, the Licensed Software is being delivered to
CUSTOMER in object code form only.

Nortel Networks or any of its suppliers holding any intellectual property rights in any Licensed Software, and/or
any third party owning any intellectual property rights in software from which the Licensed Software was
derived, are intended third party beneficiaries of this License.  All grants of rights to use intellectual property
intended to be accomplished by this License are explicitly stated.  No other grants of such rights shall be
inferred or shall arise by implication.

CUSTOMER warrants to Nortel Networks that CUSTOMER is not purchasing the rights granted by this License
in anticipation of reselling those rights.

CUSTOMER shall:

* Hold the Licensed Software in confidence for the benefit of Nortel Networks and/or Nortel Network's
suppliers using no less a degree of care than it uses to protect its own most confidential and valuable
information; and

* Keep a current record of the location of each copy of Licensed Software made by it; and

* Use each copy of Licensed Software only on a single CPU at a time (for this purpose, single CPU shall
include systems with redundant processing units); and

* Affix to each copy of Licensed Software made by it, in the same form and location, a reproduction of
the copyright notices, trademarks, and all other proprietary legends and/or logos of Nortel and/or
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Nortel's suppliers, appearing on the original copy of such Licensed Software delivered to
CUSTOMER; and retain the same without alteration on all original copies; and

* Issue instructions to each of its authorized employees, agents, and/or representatives to whom Licensed
Software is disclosed, advising them of the confidential nature of such Licensed Software and to
provide them with a summary of the requirements of this License; and

* Return the Licensed Software and all copies through an Authorized Distributor to Nortel Networks at
such time as CUSTOMER chooses to permanently cease using it.

CUSTOMER shall not:

* Use Licensed Software (i) for any purpose other than Customer's own internal business purposes and
(ii) other than as provided by this License; or

* Allow anyone other than Customer's employees, agents and/or representatives with a "need to know" to
have physical access to Licensed Software; or

* Make any copies of Licensed Software except such limited number of object code copies in machine
readable form only, as may be reasonably necessary for execution or archival purposes only; or

* Make any modifications, enhancements, adaptations, or translations to or of Licensed Software, except
as may result from those CUSTOMER interactions with the Licensed Software associated with normal
use and explained in the associated documentation; or

* Attempt to reverse engineer, disassemble, reverse translate, decompile, or in any other manner decode
Licensed Software, in order to derive the source code form or for any other reason; or

* Make full or partial copies of any documentation or other similar printed or machine-readable matter
provided with Licensed Software unless the same has been supplied in a form by Nortel Networks
intended for periodic reproduction of partial copies; or

* Export or re-export Licensed Software and/or associated documentation from the fifty states of the
United States and the District of Columbia.

* NOTE:  notwithstanding the above restrictions, if Customer has licensed the Licensed Software under a
"site license" option as set forth in Customer's Purchase Agreement, Customer is authorized to make a
limited number of copies of the Licensed Software and documentation to support additional users as
specified in Customers Purchase Agreement.

CUSTOMER may assign collectively its rights under this License to any subsequent owner of the Hardware, but
not otherwise, subject to the payment of the then current license fee for new users, if any.  No such assignment
shall be valid until CUSTOMER (1) has delegated all of its obligations under this License to the assignee; and
(2) has obtained from the assignee an unconditional written assumption of all such obligations; and (3) has
provided Nortel a copy of such assignment, delegation and assumption; and (4) has transferred physical
possession of all Licensed Software and all associated documentation to the assignee and destroyed all archival
copies.

Except as provided, neither this License nor any rights acquired by CUSTOMER through this License are
assignable.  Any attempted assignment of rights and/or transfer of Licensed Software not specifically allowed
shall be void and conclusively presumed a material breach of this License.

If Nortel Networks (i) claims a material breach of this License, and (ii) provides written notice of such claimed
material breach to CUSTOMER and (iii) observes that such claimed material breach remains uncorrected and/or
unmitigated more than thirty (30) days following Customer's receipt of written notice specifying in reasonable
detail the nature of the claimed material breach, then CUSTOMER acknowledges that this License may be
immediately terminated by Nortel Networks and CUSTOMER further acknowledges that any such termination
shall be without prejudice to any other rights and remedies that Nortel Networks may have at law or in equity.
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EXPRESS LIMITED WARRANTlES FOR ANY ITEM OF LICENSED SOFTWARE, IF ANY, WILL BE
SOLELY THOSE GRANTED DIRECTLY TO CUSTOMER BY DISTRIBUTOR AS DESCRIBED IN THE
BODY OF THE AGREEMENT TO WHICH THIS LICENSE IS ATTACHED OR, IN THE CASE OF
LICENSED SOFTWARE DISTRIBUTED IN A SEALED DISK PACKAGE, THOSE WHICH APPEAR AT
THE END OF THIS LICENSE AGREEMENT.  OTHER THAN AS SET FORTH THEREIN, THIS LICENSE
DOES NOT CONFER OR GRANT ANY WARRANTY TO CUSTOMER FROM OR BY Nortel; THE
LICENSED SOFTWARE IS PROVIDED BY Nortel Networks "AS IS" AND WITHOUT WARRANTY OF
ANY KIND OR NATURE, WRITTEN OR ORAL, EXPRESS OR IMPLIED, INCLUDING (WITHOUT
LIMITATION) THE IMPLIED WARRANTIES OF MERCHANTABILITY AND OF FITNESS FOR A
PARTICULAR PURPOSE.  THIS LIMITATION OF WARRANTIES WAS A MATERIAL FACTOR IN THE
ESTABLISHMENT OF THE LICENSE FEE CHARGED FOR EACH SPECIFIC ITEM OF SOFTWARE
LICENSED.

IN NO EVENT WILL Nortel Networks AND/OR Nortel Network's SUPPLIERS AND THEIR DIRECTORS,
OFFICERS, EMPLOYEES OR AGENTS BE LIABLE TO OR THROUGH CUSTOMER FOR INCIDENTAL,
INDIRECT, SPECIAL, CONSEQUENTIAL, PUNITIVE, OR EXEMPLARY DAMAGES OF ANY KIND,
INCLUDING LOST PROFITS, LOSS OF BUSINESS OR BUSINESS INFORMATION, BUSINESS
INTERRUPTION, OR OTHER ECONOMIC DAMAGE, AND FURTHER INCLUDING INJURY TO
PROPERTY, AS A RESULT OF USE OR INABILITY TO USE THE LICENSED SOFTWARE OR
BREACH OF ANY WARRANTY OR OTHER TERM OF THIS LICENSE, REGARDLESS OF WHETHER
Nortel AND/OR Nortel's SUPPLIERS WERE ADVISED, HAD OTHER REASON TO KNOW, OR IN FACT
KNEW OF THE POSSIBILITY THEREOF.

CUSTOMER ACKNOWLEDGES THAT THE FOREGOING PARAGRAPH REFLECTS AN INFORMED,
VOLUNTARY ALLOCATION BETWEEN THE PARTIES OF THE RISKS (KNOWN AND UNKNOWN)
THAT MAY EXIST IN CONNECTION WITH THIS LICENSE, THAT SUCH VOLUNTARY RISK
ALLOCATION WAS A MATERIAL PART OF THE BARGAIN BETWEEN THE PARTIES, AND THAT
THE ECONOMIC AND OTHER TERMS OF THIS LICENSE WERE NEGOTIATED AND AGREED TO
BY THE PARTIES IN RELIANCE ON SUCH VOLUNTARY RISK ALLOCATION.

IN THE EVENT CUSTOMER HAS NOT EXECUTED A SEPARATE PURCHASE AGREEMENT WITH A
DISTRIBUTOR, AND THIS LICENSE BECOMES EFFECTIVE BY REASON OF YOUR OPENING A
SEALED DISK PACKAGE.  THE ADDITIONAL WARRANTY PROVISIONS AND LIMITATIONS
LISTED BELOW APPLY:

* "LICENSED SOFTWARE" SHALL MEAN THE COMPUTER PROGRAMS WHICH ARE EITHER
OWNED BY OR LICENSED TO Nortel Networks AND WHICH ARE CONTAINED ON THE
DISKS SUPPLIED TO CUSTOMER.  "HARDWARE" SHALL MEAN EQUIPMENT ON WHICH
CUSTOMER USES THE LICENSED SOFTWARE.

* Nortel Networks WARRANTS THAT THE DISKS ON WHICH THE LICENSED SOFTWARE IS
RECORDED WILL BE FREE FROM DEFECTS IN MATERIALS AND WORKMANSHIP UNDER
NORMAL USE FOR A PERIOD OF NINETY (90) DAYS AS EVIDENCED BY A COPY OF THE
RECEIPT.  Nortel Network's ENTIRE LIABILITY AND YOUR EXCLUSIVE REMEDY WILL BE
REPLACEMENT OF THE DISK NOT MEETING Nortel Network's LIMITED WARRANTY AND
WHICH IS RETURNED TO Nortel Networks OR A Nortel Networks AUTHORIZED
REPRESENTATIVE WITH A COPY OF THE RECEIPT. Nortel Networks WILL HAVE NO
RESPONSIBILITY TO REPLACE A DISK DAMAGED BY ACCIDENT, ABUSE OR
MISAPPLICATION.

* IN PARTICULAR, NO WARRANTY IS BEING PROVIDED ON SOFTWARE DEVELOPED BY
THIRD PARTY SOFTWARE SUPPLIERS.  SUCH SOFTWARE SUPPLIERS MAKE NO
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED
WARRANTlES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE,
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REGARDING THE SOFTWARE.  Nortel Networks' SOFTWARE SUPPLIERS DO NOT
WARRANT, GUARANTEE OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR
THE RESULTS OF THE USE OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS,
ACCURACY, RELIABILITY, OR OTHERWISE THE ENTlRE RISK AS TO THE RESULTS AND
PERFORMANCE OF ANY SUCH SOFTWARE DEVELOPED BY SOFTWARE SUPPLIERS IS
ASSUMED BY YOU.  THE EXCLUSION OF IMPLIED WARRANTEES IS NOT PERMITTED BY
SOME JURISDICTIONS.  THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.

* BECAUSE SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF
LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE
LIMITATIONS MAY NOT APPLY TO YOU.  Nortel Networks' AND Nortel Networks'
SOFTWARE SUPPLIERS COMBINED LIABILITY TO YOU FOR ACTUAL DAMAGES FROM
AND CAUSE WHATSOEVER, AND REGARDLESS OF THE FORM OF THE ACTION
(WHETHER IN CONTRACT, TORT (INCLUDING NEGLIGENCE), PRODUCT LIABILITY OR
OTHERWISE), WILL BE LIMITED TO $50.

* THE RIGHTS AND OBLIGATIONS ARISING UNDER THIS LICENSE SHALL BE CONSTRUED
IN ACCORDANCE WITH THE LAW OF THE STATE OF TEXAS.

Version 6.00
July 1998
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Glossary of Terms

ACD

Automatic Call Distribution.  This is a telephone system feature that automatically routes calls to agents.

ANI

Automatic Number Identification.  This is another name for call ID (CLID).  ANI is typically a 10-digit number
that is delivered by the network to identify the incoming caller.

CLID

Caller identification.  This is another name for ANI.

CTI

Computer Telephony Integration.

DNIS

Dialed Number Identification Service.

DNs

Directory Numbers.

IDC

Incoming Digit Conversion.

MBS

Meridian Business Set.

MCA

Meridian Communications Adapter.

MMT

Meridian Modular Telephone.

Nortel Developer Support Hotline

For additional information or help, call (800) NT-4CTI-0.
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SCCS

Symposium Call Center Server

Service Providers

Software files needed to enable TAPI applications to communicate with the physical telephony device.

SP

Service Providers.

TAPI

Telephony Application Programming Interface.
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H

Hardware requirements
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Installation
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Modifying
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Software Installation
Desktop TAPI SP for MCA 29

Software releases
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Software requirements
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Support
Technical, product, and developer 105
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TAPI Fails to Initialize 98
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Error 98
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